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About This Manual

This manual is a quick guide to HALCON - the software solution for machine vision applica-
tions. HALCON is a sophisticated image analysis package suitable for product development,
research, and education. It provides operators covering a wide range of applications: Fac-
tory automation, quality control, remote sensing and aerial image interpretation, medical image
analysis, and surveillance tasks. For rapid prototyping, HALCON includes HDevelop, a highly
interactive programming environment which allows to design and test image analysis programs
and to generate C,%G, or COM code.

The manual provides all necessary information to install and configure HALCON, to understand
its basic philosophy, and to get acquainted with HDevelop.

The manual is intended for all new users of HALCON. It does not assume that you are an
expert in image processing. Regardless of your skills, it is quite easy to work with HALCON
using HDevelop. Anybody should be able to understand the basic HALCON principles to
solve his image analysis problems quickly. Nevertheless, it is helpful to have an idea about
the functionality ofgraphical user interfaces (GUf) and about some basic image processing
aspects.

The manual is divided into the following chapters:

e Introducing HALCON
This chapter provides a short overview of the HALCON system and points out additional
sources of information about HALCON.

e Installation, Licensing, Configuration
This chapter explains how to install and configure HALCON. Furthermore, it describes
the different types of licenses and how to obtain them.

e A First Look at HDevelop
This chapter contains a complete HDevelop session showing how to solve a specific image
analysis task from the scratch.

e Philosophy of HALCON
This chapter explains the basic data structures and mechanisms of HALCON.

e Using Parallel HALCON
This chapter shows how to use Parallel HALCON.

e Tips and Tricks
This chapter contains helpful information, e.g., for troubleshooting.

1Consult your platform’s documentation for general information.



Release Notes

Please note the latest updates of this manual:

Edition 5d, HALCON 6.0.4 (August 2003)

The manual has been clarified and extended at many points. For example, it now uses
the terms “license / license file / license key” and “update / upgrade” consistently. Fur-
thermore, it now clearly states that an application can only use one HALCON language
interface, that the license file MUST be called license.dat, warns that the number of mod-
ules should be determined in the actually used environment, and describes how to upgrade
a license. Also, the section regarding floating licenses has been extended significantly.

Edition 5¢, HALCON 6.0.3 (August 2002)

The problems occurring in conjunction with the new version of the dongle driver required
for HALCON versions> 6.0.2 and their solution are described in the corresponding sec-
tions. Furthermore, the installation process is now described in more detail, including
information on how to switch between different HALCON versions. A new section con-
tains additional information for users of ActivVisionTools.

Edition 5b, HALCON 6.0.2 (February 2002)
The manual now contains more details regarding the use of dongles (parallel port and
USB) including how to install, configure, and uninstall the corresponding device drivers.

Edition 5a, HALCON 6.0.1 (July 2001)

The manual now contains more information about how to install HALCON and the license
file when using floating licenses and about the customization of the port number of the
license server daemon. Furthermore, the section 'Troubleshooting’ now offers help if
licensing via a network board fails under Windows 2000.

Since HALCON 6.0.1 does not support HP-UX anymore, the corresponding sections have
been deleted from the manual.

Edition 5, HALCON 6.0 (October 2000)

The manual has been completely revised regarding structure and content, with exception
of the HDevelop example session. An additional chapter concerning Parallel HALCON
has been introduced. The information about installing, licensing, and configuring HAL-
CON has been extended and moved to an own chapter. The chapter "Philosophy” has been
extended by a section describing the HALCON frame grabber interface.

Edition 4, HALCON 5.2 (April 1999)

The newApply button is used in the example session. The extended menu and tool bars of
HDevelop are described in the introduction. The installation process is described in more
detail for UNIX systems.

Edition 3, HALCON 5.1 (March 1998)

The chapter “About This Manual” has been introduced. A complete revision of the manual
has been done, e.g., concerning the installation or the licensing section in chapter “Getting
Started”.

Edition 2 (November 1997)
The visualization capabilities of HDevelop have been greatly enhanced. Zooming into an
image can now be handled very conveniently, for example.
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Chapter 1

Introducing HALCON

Congratulations! With HALCON you have chosen a sophisticated image analysis package de-
signed for product development, research, and education. HALCON provides a unique library
with about 900 operators covering a wide range of image analysis tasks, data visualization,
and a comfortable debugging mechanism. HALCON operators can be used within C and C++
programs on Windows NT/2000/XP and many UNIX platforms. In addition, under Windows
NT/2000/XP, HALCON has a COM interface. This allows you to use HALCON operators from
Visual Basic, for example. Furthermore, it is very easy to integrate your own specific operators
into the system.

The HALCON data structures for iconic data provide a very convenient handling of images, re-
gions, and contours. Optimized algorithms allow high performance even on standard hardware.

The HALCON system also includes the programming environment HDevelop which allows to
speed up the design of image analysis programs. A smart online help basedparator
knowledge basprovides information about each HALCON operator, e.g., reasonable succes-
sors, possible alternatives, cross references, etc.

From version 6.0 on, HALCON exists in two versions:Besides “standard” HALCON you
can now choose Parallel HALCON. In addition to HALCON'’s image processing functional-
ity, Parallel HALCON automatically exploits multi-processor hardware and supports parallel
programming. Sesection 1.3or more information on Parallel HALCON.

Let's start with some facts describing the main characteristics of both HALCON versions.

1.1 Facts about HALCON

O HALCON'’s comprehensive operator library supports efficient, flexible image pro-
cessing and eases the development of image analysis programs
HALCON's operator library containabout 900 operatorsThe operators can be used
in any combination. All HALCON applications (e.g., HDevelop or HALCONApro-
grams) make use of the library to perform image processing tasks.
The operators exhibitlaroad range of functionalityfrom simple tasks (e.g., “read image
from file”) to complex processes (e.g., “estimate state by Kalman filtering”). Basically
they all have a rather lean complexity and are meant to process single steps of a task
instead of the whole task. So, the typical solution of an image analysis problem consists

1



CHAPTER 1. INTRODUCING HALCON

of a combination of several HALCON operators. This concept allows much greater
flexibility than others based on fewer, but more complex operators that are specialized
to perform a certain task. Specialized operators are only suitable for special tasks and
become worthless when the task changes. In contrast to this, HALCON operators may
be used in any combination.

Among the great number of operators there are some that implement the same task by
different algorithms. This allows to vary how fast and precisely a task is performed.
Consider pattern matching, for example: For a task where only the rough positions of
matching points are needed, but where the results must be returned as fast as possible,
the operatorfast_match may be used. In contrast to thisest_match is the better

choice when needing the exact positions (even with subpixel accuracy) by using a more
time-consuming algorithm.

HALCON processes color and multichannel images

HALCON works on all kinds of image data — binary, monochrome, color, or multichan-
nel images. You may use all these kinds of images in the same manner. Multichannel
images are useful to work on images that were acquired by a multisensor system.

HALCON implements efficient, fast region processing

This speeds up the processing and eases the handling of regions. Regions may overlap
and can be of any size. They are stored by an optimized encoding to reduce memory
costs.

HALCON allows to focus image processing on a region of interest

Each image object has a domain — its area of definition — that can be changed by the
user. When performing an image operator, it is processed only within the domain of the
input image. This concept allows to focus image processing and therefore to speed it up.

HALCON provides very fast pattern matching operators.

Pattern matching is very helpful in numerous areas of application, but often not used
due to its costs of computation time. HALCON allows to use pattern matching where
you want to, as it uses a very efficient implementation of various pattern matching algo-
rithms.

HALCON provides shape-based matching operators that work even in the presence
of occlusion or clutter.

HALCON provides not only pattern matching but aldmape-basethatching operators.
With these operators, you can recognize objects even if they are rotated, partly occluded
or in the presence of clutter or changing illumination conditions.

HALCON provides an easy handling of tuple objects and processes tuple elements
simultaneously.

Tuples are very helpful in many areas of application, since they enable you to work with
sets of images, regions, or control data. With HALCON, tuples of objects or control
values can be handled just as one object. Operators can either work on a single or on
a tuple object. You need not bother about the amount of elements within a tuple. You
simply pass one variable containing the tuple to an operator. HALCON decomposes it
and works simultaneously on the tuple elements.

HALCON is based on an efficient management of image and data objects

The HALCON memory manager uses fast, efficient algorithms to speed up image pro-
cessing. It provides mechanisms for controlled memory access and services for debug-

Getting Started with HALCON, 2003-08-01



1.1. FACTS ABOUT HALCON 3

ging, such as checking with every deallocation whether any write access exceeded the
allocated memory block. The HALCON image database provides several services for

object handling to allow a fast and transparent access to image data. Images are held in
memory. To reduce memory costs data is shared by different objects whenever possible.

O HALCON provides interfaces to the programming languages C, G+, and COM.

The HALCON system includes interfaces to the programming languages$€,a0d
COM:. This allows you to use HALCON operators inside your own &;Cor COM
programs and to build stand-alone applications.

O HALCON provides the tool HDevelop for interactive development of image analy-
sis programs
In most cases, developing image analysis programs is a complex and time-consuming
task. To help the user to find the right operators and parameters for a given task, HAL-
CON provides theComputer Aided Vision Engineering tddDevelop. This eases de-
veloping programs in several ways: First, HDevelop hgsaphical user interfacéhat
allows an easy, intuitive handling of operators and image data. Secondly, operators can
be processed and combined interactively. All results are immediately visualized so that
the user can experiment with different operators and parameter values and directly sees
the result. Moreover, HDevelop supports the user by suggesting appropriate operators
and parameter values. Amline helpexplains how the operators work and illustrates
their usage by examples.

If you are satisfied with the result you can save the developed program either in a special
HDevelop file format to load it again into HDevelop later on or export the program as
C, Ct+, or COM source code. By exporting, the program can be used by other image
analysis applications and can be edited and optimized just like any “hand-written” image
processing program.

O HALCON already provides interfaces to more than 50 frame grabbers

HALCON supports more than 50 frame grabbers (the current list can be found at
http://www.mvtec.com/halcon/) by providing interfaces to their SDKs. To estab-

lish a connection to one of these frame grabbers, all you need to do is to call the operator
open_framegrabber with parameters describing the desired image format and grabbing
mode. Then, you can grab images simply by calling the opegatds_image.

O New frame grabbers may easily be integrated

If you use a frame grabber not already supported by HALCON, you can easily integrate a
corresponding interface into HALCON. For this, HALCON provides a transparent frame
grabber interface with sample source code for integrating new frame grabbers. The only
thing you have to do is to adapt this code to a specific frame grabber and to link it to the
HALCON code. TheFrame Grabber Integration Programmer’s Manual describes

in detail how to do this.

Alternatively, you can convert your own images to HALCON images by passing HAL-
CON a pointer to the image buffer using the opergtar_imagel_extern.
O HALCON may easily be extended by new operators

Although HALCON already contains about 900 operators for various tasks, you may
wish to implement a new one, e.g., in order to access a special hardware or to implement

1 COM is a Microsoft standard for component-based software; programs written in COM can be used in
environments such as Visual Basic, Visual C++, Microsoft .NET, or Delphi.

HALCON 6.0.4



4 CHAPTER 1. INTRODUCING HALCON

an alternative algorithm. To do so, HALCON provides the Extension Package Interface
that allows the integration of new operators (implemented in C). It contains several pre-
defined routines and macros for the easy handling of image data and memory objects in
C. Once a new operator has been successfully integrated, it can be used like any other
HALCON operator. Thé&xtension Package Programmer’s Manuatontains detailed
information about extending the operator library.

O HALCON allows continued application of already implemented image processing
software.

Software engineering is a time consuming process and in most cases expensive as well.
So, everyone is interested in using already implemented software as long as possible,
and no one is bent on re-implementing their software with every installation of new
software components. Therefore, HALCON supports the continued application of al-
ready implemented software: Convert your programs into new HALCON operators to
use them within HALCON as described above. Moreover, HALCON hardly restricts the
hardware configuration. A wide range of machines and systems can be used. Various
frame grabbers are supported. New ones may be easily integrated (see below). Thus,
you need not change your hardware configuration and therefore also need not to change
your software.

O HALCON supports a wide range of platforms.

HALCON is largely architecture independent and therefore allows you to use the system
of your choice. It supports different platforms, such as Windows NT/2000/XP, Linux,
Solaris, Tru64 UNIX (formerly called DIGITAL UNIX), or IRIX. Sesection 1.Zor

more information.

O HALCON supports multi-threaded applications by being thread-safe

HALCON is thread-safe under Windows NT/2000/XP, Linux, and Solaris. Note that
for an extensive use of parallel programming techniques, you should choose Parallel
HALCON (seesection 1.3

O HALCON supports data exchange with other applications

For easy exchange of image data HALCON supports several file formats, such as Tiff,
Sun-Raster, Gif, PNM, PNG, JPEG, PCX, XWD, BMP, binary. Other data (e.g., inte-
ger result values for image coordinates) may be exchanged via the HALCON language
interfaces.

O How is HALCON related to HORUS?

HALCON is the commercial successor of the image analysis system HGRW&;h

was developed at théhair Informatics IXof Prof. B. Radig at th&echnische Univer-

sitat Minchenfrom 1988 to 1996 for UNIX systems only. Although MVTec took over

the basic concepts of the system, all the major components have been revised. Fur-
thermore, HALCON provides many new features and operators compared to the last
HORUS version 4.11. Existing HORUS applications can be adapted to the HALCON
system, but since the names and interfaces of many operators have been modified some
amount of programming is necessary to do that.

°The name was changed mainly due to international trademark considerations.

Getting Started with HALCON, 2003-08-01



1.2. SYSTEM REQUIREMENTS 5
1.2 System Requirements

Table 1.1shows the requirements for running HALCON 6.0 on the different supported op-
erating systems. It should run on newer versions of an operating system; however, we cannot
guarantee this. Windows NT is no longer supported on Alpha processors, following Microsoft's
corresponding decision.

Operating System Processor Compiler
Windows NT 4.0/ 2000/ XB compatible to Intel Pentium MS Visual Studio
Linux 2.2/2.4 compatible to Intel Pentiumgcc 2.95

Solaris 7 SPARC CC 5.2

IRIX 6.5 MIPS CC

Tru64 UNIX 5.1 Alpha CXX

Table 1.1: Platforms supported by HALCON .

Note that under Linuxibc6 (glibc-2.1.x) is required, which is the case for most current
Linux distributions like RedHat or SUSE. Please check your distribution’s documentation.

HALCON can also be used on the Philips TriMedia DSP, with the host computer running Win-
dows NT/2000/XP. Please refer to tHALCON/C User’'s Manual for more infomation.

1.3 Introducing Parallel HALCON

To put it in a nutshell, standard HALCON is optimized for runnisgquential programs

on single-processor boardsUnder Windows NT/2000/XP, Linux, and Solaris, HALCON is
thread-safei.e., it can be used in multi-threaded programs. However, all HALCON operators
are executee@xclusivelythus threads will have to wait for each other.

In contrast, Parallel HALCON suppornarallel programminge.g., multi-threaded programs)
by being thread-safand reentrant This means that multiple threads can call a HALCON
operator simultaneously Parallel HALCON is available for Windows NT/2000/XP, Linux,
and Solaris.

Besides supporting parallel programming, Parallel HALC&NXbmatically parallelizes opera-
torsif started on multi-processor hardware, e.g., a dual-pentium board. This mechanism is fully
compatible to older HALCON versions, i.e., old HDevelog;*Cor C programs do not need to

be changed.

The parallelization mechanism is based on distributing the data which has to be processed, i.e.,
the images, on multiple threads that run on different processors (so-caltagparallelisn).

For example, for a filtering operation on a four-processor board the image will be split into
four parts which will then be processed in parallel by four threads executing the (same) filtering
operator. Together with HALCON'’s philosophy for treating images and regions, this form of
parallelization is very efficient because images need not to be copied.

3Note that some operators can only be called exclusively because of functional or technical reasons. See
section 5.2.Tor more information.

HALCON 6.0.4



6 CHAPTER 1. INTRODUCING HALCON

The degree of parallelization is optimized online to minimize the parallelization overhead. For
example, very small images will not be processed in parallel, as the overhead would surpass the
parallelization speed-up. Moreover, not all HALCON operators lend themselves to paralleliza-
tion.

To be able to exploit your multi-processor hardware optimally, Parallel HALCON has to check
the hardware once after being install&ection 5.1.Hescribes how to start and configure this
initialization.

Note that Parallel HALCON is designed fehared-memory systemse., systems in which
multiple processors share a common memory as it is the case for typical multi-processor boards.
The main reason is that only in a shared-memory system threads can share the HALCON object
database and do not need to copy images. This limitation means that Parallel HALCON is not
suited to the use on workstation clusters or other multi-processor hardware that does not offer
shared memory.

1.4 Additional Sources of Information

For further information you may consult the following manuals:

e HDevelop User’'s Manual
An introduction to the graphical development environment of the HALCON system.

e HALCON/C ++ User’s Manual
How to use the HALCON library in your C++ programs.

e HALCON/C User’'s Manual
How to use the HALCON library in your C programs.

¢ HALCON/COM User’'s Manual
How to use the HALCON library in your COM programs, e.g., in Visual Basic.

e Extension Package Programmer’s Manual
How to extend the HALCON system with your own operators.

e Frame Grabber Integration Programmer’s Manual
A guide on how to integrate a new frame grabber in the HALCON system.

e HALCON/HDevelop, HALCON/C ++, HALCON/C , HALCON/COM
The reference manuals for all HALCON operators (versions for HDevelap, C, and
COM).

All these manuals are available as PDF documents. The reference manuals are available as
HTML documents as well. For the latest version of the manuals please check

http://www.mvtec.com/halcon/

Getting Started with HALCON, 2003-08-01



Chapter 2

Installation, Licensing, Configuration

Before describing how to install and configure HALCON, let’s take a look at the different
HALCON versions and licensing schemes.

You can obtain HALCON in three versions:

1. Thedemo versioris basically a version of HDevelop with the full image processing
functionality but some limitations, e.g., without frame grabber or programming language
interfaces. Using the demo version, you can test all HALCON operators within the
HDevelop environment for an unlimited amount of time.

2. At the other end of the spectrum lies fiadl version which is used to develop applica-
tions based on HALCON. Besides HDevelop, this version includes interfaces to about
50 frame grabbers and an interface to integrate additional ones, language interfaces to
C, C++, and COM, and the Extension Package Interface, which allows you to integrate
your own HALCON operators.

3. If you have developed an application based on HALCON, you can obteintane
versionof HALCON, which only contains the image processing functionality needed in
your application. A runtime version does not include HDevelop.

For the development version and for the runtime version you need a corresponding license key.
The demo version can be used without a licei$ere are two possible licensing schemes:

1. Nodelockedicenses are only valid for one specific host or hardware dongle.

2. For a development version you can also get a so-cbhatinglicense. Such licenses
are valid on arbitrary hosts within a local network. A so-caliednse servechecks
the number of currently active HALCON applications. A new application can be started
only if the overall number of licenses is not exceeded.

Note that a computer acting as the HALCON license server need not be a “server” in the
sense that it must be a “big” server machine or have a special kind of operating system,
e.g., Windows NT Server, installed. Moreover, you can use different architectures for
the license server and the HALCON applications, respectively, e.g., a Linux workstation
for the license server and Windows for running HALCON. The only requirement is that
the computer acting as the license server must be accessible whenever HALCON is to
be used.

Please note, that for evaluating purposes you can obtamporary licensé&om you distributor
free of charge.
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2.1 Installation

This section describes how to instal HALCON from CD; how to in-
stall HALCON from the WWW is described in MVTec's download area
(http://www.mvtec.com/halcon/download). Most of the work is done by the pro-
vided installation scripts. The fileelease notes.html within the HALCON package

contains the latest information.

Except of UNIX-specific sections, file paths and environment variables are printed in the Win-
dows convention, e.g.,

J#HALCONROOT%\examples\extension_package\halconuser

to denote the subdirectobalconuser containing an example package within the HALCON
base directory referenced by the environment vari@hleCONROOT (seesection 2.4for more
information on environment variables). The same expression in UNIX convention would look
like

$HALCONROOT/examples/extension_package/halconuser

Prior to installing a new HALCON version, e.g., HALCON 6.0.x over HALCON 5.2.x,
you should uninstall any existing old version.Under Windows, this is especially important
in order to clean up the registry. Sgection 2.2about how to uninstall HALCON.

If you want to install a new maintenance release over an existing release based on the same ver-
sion, e.g., HALCON 6.0.4 over HALCON 6.0.3 or 6.0, you can use a special update mechanism
(seesection 2.1.3

2.1.1 Installing HALCON Under Windows NT/2000/XP

To install HALCON on Windows NT/2000/XP systems, simply insert the CD. This should
automatically start the setup program. If the setup program doesn’t start automatically, execute
the Setup. exe program located in the directoft-intel of the CD. Please note, that you
need administrator privileges in order to install HALCON.

First, the setup program checks whether your system meets the requirements for running HAL-
CON (seesection 1.2

Then, it checks whether HALCON is already installed on your computer and, if yes, which
release is installed:

e same release or same versiotf you already installed the same release or another release
of the same version, e.g., if the setup of HALCON 6.0.4 detects HALCON 6.0.3, the setup
determines the installed components and lets you install additional parts.

Thus, if you want to install a maintenance release over another release based on the same
version, you must either uninstall the older release first or use the special update mecha-
nism described isection 2.1.3
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e other version: If the setup detects a release of another HALCON version, e.g., if the
setup of HALCON 6.0.4 detects HALCON 5.2.3, it asks whether you want to keep the
old version. For more information about switching between multiple HALCON versions
please refer tgection 2.1.5

The setup program also checks whether you have installed ActivVisionTools, and whether the
installed version is compatible to the current HALCON version. Please refgdiion 2.1.6
for more information.

After all these checks, the installation wizard allows to specify whether you would like to in-
stall

e the full HALCON version Compact, Custom, Typicall),
e the runtime version onlyRuntime), or
e justthe demo versiohdevelop_demo.exe (Demo).

Note that you can install additional parts of HALCON at a later time by inserting the CD again
and selecting the parts you need.

After this selection, the setup program asks whether to install the driver programs, which are
necessary if you want to use a dongle licer$3ection 2.3.%rovides detailed information about
dongle drivers, including how to install them manually if you didn’t let HALCON do it.

The next dialog asks whether the computer is to act afidagng license serverin this case,

the setup program installs the so-callegnse manager daempa system service that manages
your floating licenses. Note that when using floating licenses, you need to install the license
manager daemon only on one computer: the license server. Please sefeida 2.3.4or more
information about floating licenses, e.g., how to install the license manager daemon manually.

After some further questions the actual installation starts.

2.1.2 Installing HALCON Under UNIX

To install HALCON on UNIX systems, mount the CD, e.g., on the directagrom. On most
systems, you neetbot rights to do so. Note that on some systems, most notably Linux, the
default mount entry, usually inetc/fstab, does not allow user to execute programs on a CD.
In such cases, you have to mount the CD explicitly with a command similar to the following:

mount /dev/cdrom /cdrom

For the installation, start the shell scrifpistall-unix which is located in the top-level di-
rectory of the CD. This script will ask you in which directory you want to install HALCON;
the environment variabl#ALCONROOT has to be set to this directory later, ssection 2.4.2
Furthermore, the script asks whether to install various components of HALCON.

Since all directories and files on the CD are read-only, you may get some warnings about
changed permissions if you run the installation script as an ordinary usesqasno warnings

!Please note, that if you chooSgpical, most of the image sequences are not installed. This means that
example programs based on such an image sequence cannot be run. A quick remedy in such a case is to mount
the HALCON CD again, as the example programs also look there for the images. Of course, you can also install
additional parts of HALCON at a later time.
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of this kind should appear). Furthermore, on some systems you may get complaints about the
fact that the CD contains files with file names longer than 32 characters.

Note that the installation script checks whether your system meets the requirements for running
HALCON (seesection 1.2

After the installation, several environment variables need to be set in order for HALCON to
work. Seesection 2.4.Zor details.

Note that you can install additional parts of HALCON at any time by mounting the CD again and
copying the corresponding directories and files to the diectory where you installed HALCON.
To copy directories, open a shell, change into the root directory on the CD, and type

tar -cf - <directory_to_be_copied> | ( cd $HALCONROOT; tar -xf - )

If you are using floating licenses, please note the following: After installing HALCON on the
computer acting as the license server for the first time, you must install and start the license
manager daemon as describedsettion 2.3.4.2 If you update from an existing HALCON
version to HALCON 6.0.4, you musgstart the license manager daemoyrseesection 2.3.4.3

for detailed information.

2.1.3 Updating HALCON (Windows NT/2000/XP only)

For Windows NT/2000/XP systems, there is a special mechanism which lets you up-
date HALCON to a newer maintenance release of the same version, e.g., from HAL-
CON 6.0 or 6.0.1 to HALCON 6.0.4. Please refer to the HALCON download area
(http://www.mvtec.com/halcon/download) for more details.

Updating to HALCON 6.0.2 or higher

From version 6.0.2 on, HALCON requires a newer version of the dongle driver programs from
GLOBEtrotter (see alssection 2.3.5 However, the update mechanism only provides the new
setup programs; it neither uninstalls the old driver nor does it install the new one. As a conse-
guence, HALCON reports “license not found” or a similar error message. Therefore, when
updating from HALCON 6.0.1 (or 6.0) to 6.0.2 or higher you must uninstall the old driver and
install the new one manually as describedéction 2.3.5.1

Special Information for Users of Floating Licenses

If you are using floating licenses, please note the following: Before extracting the ZIP file on the
computer acting as the license server, you rsteg the license manager daemoas described

in section 2.3.4.10therwise, you will get an error message during the extraction, because the
two filesmvtecd.exe andlmgrd.exe cannot be replaced while the daemon is running. In this
case, stop the daemon and repeat the extraction.

After the extraction, you must restart the license manager daemosdseen 2.3.4.8
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Special Information for Users of ActivVisionTools

As described in more detail section 2.1.6none of the ActivVisionTools versions is fully com-
patible to HALCON 6.0.2 and higher versions. For ActivVisionTools 2.0, there exists a hew
OCX that is compatible to HALCON 6.0.2 and higher versions. If you use the setup program of
HALCON 6.0.3 or 6.0.4, it offers to replace the corresponding QXivVTools.ocx With

a new one automatically. However, when you use the special update mechanism, you must
perform the necessary actions manually: First, download this new OCX (from the same page as
the HALCON ZIP file); then, unregister the old OCX and register the new one as described in
section 2.1.6

2.1.4 The Installed HALCON File Structure

Let’s take a look at the installed HALCON file structure in the directiiygLCONROOT?. In
the following, the most important directories and files are described briefly. Please note, that
depending on your installation, not all directories will be present.

e FLEX1m: This directory contains programs used for licensing @sstion 2.3, in subdi-
rectories corresponding to the different platforms.

e bin: This directory contains HALCON programs, for example HDevelop (Windows:
hdevelop.exe; UNIX: hdevelop), again in subdirectories corresponding to the different
platforms. For Windows, this directory also contains the DLL version of the HALCON
libraries and the libraries for the supported frame grabbers interfaces.

e doc\pdf: Here, you find the PDF version of the user's manuals (subdireetaryals
and of the reference manuals (subdirectosyerence).

e cxamples: The subdirectories of this directory contain example programs for the different
parts of the HALCON system:
> c¢: Examples for using HALCON within the programming language C (see also the
HALCON/C User’'s Manual).

> cpp: Examples for using HALCON within the programming language C++ (see also
theHALCON/C ++ User’s Manual).

> delphi: Examples for using HALCON within Borland Delphi.

> fg_integration: Example programs for frame grabber interfaces (see also the
Frame Grabber Integration Programmer’s Manual ).

> extension_package: The example user packagealconuser (see also the
Extension Package Programmer’s Manua).

> hdevelop: Examples for using HDevelop, together with the example pro-
grams described in the manu@etting Started with HALCON (subdirectory
Manuals\Getting Started) and in theHDevelop User's Manual (subdirectory
Manuals\HDevelop).

> mfc: Examples for using HALCON together with MFC (see also the
HALCON/C ++ User’s Manual and theHALCON/COM User’s Manual ).
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> motif: Examples for using HALCON together with Motif (see also the
HALCON/C ++ User’'s Manual).

> vb: Examples for using HALCON within Visual Basic, together with the example
programs described in tHdALCON/COM User’s Manual .

Please note, that the examples should not be used directly for two reasons: First, on most
platforms only the user who installed HALCON is allowed to save a (modified) example
program. More importantly, on some operating systems not all users have the permission
to create new files in the example subdirectories; this causes errors in those example pro-
grams which contain operators that write data to files. To experiment with examples we
therefore recommend to create a private copy in your own working directory.

e images: This directory contains example images and, in subdirectories, image sequences.
These images are used by the example programs described above.

e include: This directory contains the header files which are necessary to use HALCON
within the programming languages C or C++.

e 1lib: This directory contains the HALCON libraries and the libraries for the supported
frame grabbers interfaces (Windows: file extensianb; UNIX: file extension.so),
again in subdirectories corresponding to the different platforms.

e license: Thelicense fildicense.dat mustbe placed in this directory (ssection 2.3

2.1.5 Switching Between Different HALCON Versions

You can install multiple HALCON versions on a computer and then switch between them.
Under Windows NT/2000/XP,you must adapt those environment variables that are set during
the installation, i.e.,PATHY, %HALCONROOT%, and,HALCONIMAGES?Y, and those you set yourself
(e.g.,.HALCONEXTENSIONSY). Please refer teection 2.4.Xor more information about setting
environment variables.

If you are using the HALCON/COM interface, you must also re-register the corresponding
DLL halconx.dl1, for example as follows: Open a Windows Command Prompt and change
into the subdirectorpin\i586-nt4 of the root directory of your “old” HALCON installation.
Unregistemhalconx.d11 by typing

regsvr32 /u halconx.dll

Then change into the corresponding subdirectory of your other HALCON installation and reg-
ister itshalconx.d11 by typing

regsvr32 halconx.dll

As an alternative to the Command Prompt, you can unregister and regidigimx .d11 via
the dialogStart > Run together with the Windows Explorer: In the latter, “open” the di-
rectory bin\i586-nt4 of the root directory of your old HALCON installation. Now, type
regsvr32 /u the dialogRun and then drag and drdglconx.d11 from the Explorer into the
dialog, where it automatically appears with the full path. To execute the commandpklick
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Then, open the directoryin\i586-nt4 of the root directory of the other HALCON installa-
tion in the Explorer, typeregsvr32 in the dialogRun, drag and dropralconx.d1l from the
Explorer into the dialog, and again click.

Under UNIX, you switch to another HALCON version by setting the environment variables
$HALCONROOT (and derived variables likHALCONIMAGES), $PATH, and $LD_LIBRARY PATH
accordingly (see alssection 2.4.2

2.1.6 Information for Users of ActivVisionTools

Please note that the ActivVisionTools version 2.1 and higher are based on HALCON 6.1 and
therefore cannot be used together with HALCON 6.0.x. Unfortunately, also the ActivVision-
Tools versions 1.0 to 2.0, though based on HALCON 6.0 or 6.0.1, are not fully compatible to
HALCON 6.0.2 and higher versions; thus, by installing such a HALCON version you would
disable your ActivVisionTools installation! Therefore, the setup program of HALCON 6.0.3
and 6.0.4 checks whether there is an ActivVisionTools installation on your computer. If it de-
tectsActivVisionTools 2.0, it offers to replace the corresponding OG@%tivVTools.ocx with

a new one which is compatible to HALCON 6.0.3 or 6.0.4, respectively. Typically, you will
choose this option. If not, you can replace it manually as follows: Open a DOS shell and change
into the subdirectorypin\i586-nt4 of the root directory of your ActivVisionTools installation.
UnregisterActivVTools.ocx by typing

regsvr32 /u ActivVTools.ocx

Then delete the OCX (or rename it) and replace it by the new one, which can be found in
the ActivVisionTools download area{tp://www.activ-vision-tools.com/download).
Register the new OCX by typing

regsvr32 ActivVTools.ocx

As an alternative to the Command Prompt, you can unregister and register the OCX via the
dialog Start > Run together with the Windows Explorer: In the latter, “open” the direc-
tory bin\i1586-nt4 of the root directory of your ActivVisionTools installation. Now, type
regsvr32 /u the dialogRun and then drag and drofctivVTools.ocx from the Explorer

into the dialog, where it automatically appears with the full path. To execute the command,
click OK. Then, replace the OCX with the new open, typegsvr32 in the dialogrun, drag and
dropActivVTools.ocx from the Explorer into the dialog, and again cliak.

If you decided to switch back to an older HALCON version as describesgation 2.1.5you
must of course unregister the new OCX and register the old one; if you deleted it you can
recover it from the corresponding directory on the ActivVisionTools 2.0 CD.

In contrast to ActivVisionTools 2.0for ActivVisionTools 1.0 to 1.3 no compatible OCX is
available. If the setup program of HALCON 6.0.3 or 6.0.4 detects such an ActivVisionTools
version, e.g., ActivVisionTools 1.3, it therefore only warns that by continuing you will disable
your ActivVisionTools installation. The same happens if it detects ActivVisionTools 2.1 or
higher.

HALCON 6.0.4



14 CHAPTER 2. INSTALLATION, LICENSING, CONFIGURATION
2.2 Uninstallation

2.2.1 Uninstalling HALCON Under Windows NT/2000/XP

There are multiple ways to uninstall HALCON; please note that not all are available for older
versions of HALCON:

1. Inthe system control panel choas®l/Remove Programs.

2. If the HALCON release you want to uninstall is newer than version 5.1: Sgteet
> Programs > MVTec HALCON > Uninstall HALCON.

3. Fromversion 5.2 on, the HALCON setup program checks whether there is an old version
of HALCON and allows you to uninstall it. This is the preferred way since it avoids the
problem with the path variable described below. Note however, that this method does
not work if you want to uninstall an older maintenance release based on the same version
of HALCON.

Typically, this is all you have to do. If you encounter any problems, please resectmn 6.5.2
If you want to uninstall HALCON before installing HALCON 6.0.2 or higher versions, please
check the paragraph below for additional information.

Note that the uninstallation removes exactly those files which were installed. This has two im-
plications: If you added files after the installation, e.g., new frame grabber interfaces, extension
packages, images, or manuals, these files and the corresponding directories will “survive” the
uninstallation. On the other hand, if you only modified a file, e.g., an example, without chang-
ing its name the uninstallation will remove it nevertheless; you might therefore want to copy
such files to another directory before starting the uninstallation.

The uninstallation warns if it encounters DLLs or executables that might be or are actually
used by another application. The warnings regardiigonx.d11 andHFGDirectShow.d11l

can safely be ignored, i.e., the files can be removed. Warnings regardirgd.exe and
lmgrd.exe indicate that the license manager daemon was installed manually. In this case,
we recommend to check whether the license manager daemon is still running as described in
section 2.3.4.1and to stop it manually if necessary. Then, the two files can be safely deleted
manually.

The uninstallation process will not remove amger-specific settingsrhis means that registry
entries concerning, e.g., the layout of HDevelop or its file history, will be left in the category
HKEY_CURRENT_USER 1> Software > MVTec > HALCON. You may remove these entries manually
without risk. Furthermore, it does not remove the dongle drivers as they might be needed by
another applicatiorsection 2.3.3lescribes how to remove them manually.

Special Information for HALCON 6.0.2 or higher

From version 6.0.2 on, HALCON requires a newer version of the dongle driver programs from
GLOBEtrotter (see alseection 2.3.5 However, the uninstallation process does not uninstall
the old dongle driver; as a consequence, during the installation of HALCON 6.0.2 (or a higher
version) the new driver cannot be installed (even if the setup program might state that the in-
stallation was successful!).

Therefore, you mustininstall the dongle driver manually before uninstalling HALCON!
Please refer tsection 2.3.5.%or more information.
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2.2.2 Uninstalling HALCON Under UNIX

To uninstall an existing HALCON system, just remove the contents of the HALCON base
directory$HALCONROOT and all its subdirectories, e.g., by executing

rm -rf $HALCONROOT

Furthermore, remove the subdirectatydevelop of the directory referenced by the environ-
ment variablélOME (seesection 2.4.2, HDevelop creates this directory to save options, window
positions, and the file history.

The uninstallation process will not remove amer-specific settingg his means that environ-
ment variables remain unchanged and have to be adapted or deleted manually.

If you called the operatotheck par_hw_potential from Parallel HALCON 6.0 beta to ini-

tialize Parallel HALCON (seeection 5.1.}, the file .halcon_par_info which contains the
extracted information about the host computer will be left in the directory referenced by the
environment variabl#0ME (seesection 2.4.p
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2.3 Licensing

HALCON checks whether the product is licensed to the user with the help of the FLEXIm
license managémpackage from GLOBEtrotter. In this section a brief summary of the default
procedure to obtain and install a license will be given.

The first step is of course teelect the computesn which (in case of a nodelocked license)

you want to use HALCON on or which (in case of a floating license) is to act as the license
server, i.e., which keeps track of how many licenses of HALCON are currently in use. Note
that a computer need not be a “server” in the sense that they have to be a “big” server machine
or have a special kind of operating system, e.g., Windows NT Server, installed. If you want to
run HALCON on a stand-alone computer, the license server must be this computer. If you run
HALCON on a network any computer on the network can serve as a license server.

In order to obtain a license for HALCON, you haveeixtract identifying informatioabout this
computer (sesection 2.3.Xor more details) and send it to your local distributor. If you want
to obtain a runtime license, you have to inform your local distributor which HALG@ddlules
you want to use. Please referdection 2.3.2or more information.

You will then receive dicense file Section 2.3.3escribes how to install this file on your
system. Section 2.3.4ontains additional information for the case you want to use a floating
license.

2.3.1 Extracting ldentifying Information

The standard method for identifying an computer requires that the computer of your choice is
equipped with anetwork card If you are using Windows NT/2000/XP and if your computer is
equipped with @entium Il processqrit can be identified by the so-called CPU ID as well.

Under Windows NT/2000/XP, you can also usbéadware dongle In this case, the license

will be coupled to this dongle, i.e., you can use HALCON on another computer by moving the
dongle. This has the advantage that you don’t commit yourself to using a certain computer. You
can use dongles both for nodelocked and for floating licenses. In the latter case, the dongle is
used for identifying the computer which acts as the license server. You can obtain such a dongle
from your local distributor. The dongle will be delivered together with the corresponding license
file. Seesection 2.3.50r more information regarding the use of dongles.

2.3.1.1 Extracting Information Using HDevelop

The easiest method to extract identifying information is to start the HDevelop demo version
(which is always installed). You start it under Windows NT/2000/XP, g&dlrt > Programs

> MVTec HALCON > HDevelop Demo; under UNIX, callhdevelop_demo from a shell. Now,
select the menu itemlelp > About. A dialog as depicted ifigure 2.1appears. At the bottom,

it shows all the information available on your computer, in the example the three so-called host
IDs corresponding to a network card, a Pentium 1ll, and a dongle. In most cases, you will see
only one ID.

2The full documentation of FLEXIm can be obtained from the FLEXIm end user manual available at
http://www.globetrotter.com/manual.htm.
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About HD evelop

@ HALCOM - Version B.0.

HOevelop - Wersion 3.1

% Tec Software GmbH

Funich, Germany

wial mytec.com

@ 1996-2000 MY Tec S oftware GmbH

The hostidz of thiz computer are
network card ID ———» 00e02358e36a, 0003-C1DE-01C3-E7SF, FLEXID=F-36c79bd? 4 dongle ID

CPUID / -

Figure 2.1: Identifying information in the HDevelop window About.

To obtain a license based on a network card or a Pentium Ill CPU, send the corresponding ID to
your local distributor together with the hostname of this machine in your network (for example,
halconserver). In the case of a dongle license, this is not necessary, as you will receive the
license file already together with the dongle.

If HDevelop fails to detect any host IDs although your computer does have a network card, a
Pentium Ill, or a dongle, please try to extract the host IDs manually as described in the fol-
lowing section. If IDs like"ffffffff", "0", or "" appear, please conswéction 6.5.3or
troubleshooting.

2.3.1.2 Extracting Information Using  1mhostid

As a (more tedious) alternative, you can extract these IDs by using the pragteratid
shipped together with the license manager FLEXIm. Under Windows NT/2000/XP, open
a Windows Command Prompt Under UNIX, open a shell, change into the directory
$HALCONROOT/FLEX1m and then into the subdirectory corresponding to your operating system
(e.g.,i586-1inux2.2 Ofr sparc-sun-solaris7).

To identify a computer by its network card, type 1lmhostid -ether (Or just lmhostid).
Following the example of the previous section, the output might look like this on a Windows
system:

> Imhostid -ether
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1m host ID of this machine is "00e02958e36a"

Send the ID, in this example the string0e02958e36a", to your local distributor together with
the hostname of this machine in your network (for examhtd,conserver). If lmhostid
returns"ffff££f££" or "0" please consulection 6.5.3.%or troubleshooting.

To identify a computer by its (Pentium IIl) CPU number (Windows NT/2000/XP only), type
lmhostid -cpu64. The output now might look like this:

> 1mhostid -cpu64
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1m host ID of this machine is "0003-C1DE-01C3-E79F"

3Do not start the program from the Explorer. Yowstuse a Command Prompt.
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Used Modules
4 Basic operators
4~ Image ! region / XLD management
Image fiters
Sub-pixel operators
4~ Template matching
4 Region processing
Maorphology
Background estimation
Optical character recognition
Fouriet descriptors
Wiener filter
Camera calibration
Tools
& System
Barcode reader
Optical character verification

Figure 2.2: Used modules in the example program in chapter 3.

Send the ID, in this example the strit@003-C1DE-01C3-E79F", to your local distributor
together with the hostname of this machine in your network (for exarhple;onserver). If
1lmhostid returns"", the reason probably is that the service providing the CPU ID is disabled in
the computer’s BIOS. You can check and enable this service in the BIOS configuration mode;
this mode can only be entered during the booting process. Please caedion 6.5.3.%or
troubleshooting.

To check the dongle ID(Windows NT/2000/XP only), typ@mhostid -flexid. The output
now might look like this:

> 1mhostid -flexid
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.
The FLEX1Im host ID of this machine is "FLEXID=7-36c79bd7"

Note that this number is also written on the dongle.

2.3.2 Runtime Licenses and HALCON Modules

HALCON operators are grouped into so-calladdules Some modules, e.g., ‘Basic Operators’
or 'Image / Region / XLD Management’, are used in all HALCON applications, others like
'Background Estimation’ or 1D Bar Code Reader’ will only be needed in special applications.
While the development version of HALCON automatically includes all modules, you can limit
a runtime version to the modules you actually need.

You can check which modules are used by an application in two ways:

1. If the application is running in HDevelop (sebapter 3for more information), select
the menu itenFile > Modules... which will open a pop-up dialog as depicted in
figure 2.2 Click Save to save the required modules in a file with the extensiosd in
the currently used directory.
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2. If the application is written in a programming language (C, C++, COM), insert the op-
eratorget_modules (See the corresponding entry in the HALCON Reference Manuals
for more information) at the end of the program.

Send the thus determined module names to your local distributor when requesting a runtime
license.

Please note that the number of modules depends on the used environment; for example, within
HDevelop an application may need less modules than after exporting it to Visual Basic. Thys,
we recommend tdetermine the number of modules in the environment used for the final Iﬂ
application.

2.3.3 Installing the License File

Your local distributor will supply you with a license file. This file must be put into the directory
%HALCONROOTY\1license* and be renamed tbicense.dat, if necessary%HALCONROOTY is

the HALCON base directory you have chosen during the installation. If you are using the
floating license scheme, you must copy the license file to all computers you installed HALCON
on, i.e., the computer acting as the license server and all computers where HALCON is to be
used, and then restart the license manager daemon as descrégetion 2.3.4.3

If you upgrade HALCON to a newer version, e.g., from HALCON 5.2x to HALCON 6.0.x, your
distributor provides you with a so-calleghgrade license filein this case, you must append the
content of this file at the end of the old license fil®ALCONROOT%\1icense\license.dat
(seefigure 2.5for an example). Please note that some editors insert special characters, which
cannot be interpreted by FLEXIm. Under Windows systems, we recommend to use WordPad.
Due to a bug in the FLEXIm software, you might encounter problems if you upgrade twice,
e.g., from HALCON 5.2 to 6.0 and then to 6.1. In this case, please contact your distributor for
further instructions.

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

HHHH R

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted BC4D86743889FC4CFAC2 \
VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=109

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 uncounted \
5CFD86941816A696B16F VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=30

Figure 2.3: Nodelocked development license, bound to network card.

R i

# MVTec Software GmbH (ID: FLEXID=7-b285ff7f) #

HESH A R

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted 3C574319AF86C4A5DE4A \
VENDOR_STRING=65535 HOSTID=FLEXID=7-0285ff7f ck=35

Figure 2.4: Nodelocked runtime license, bound to dongle.

4See the FLEXIm end user manual on how to configure this location.
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original license file (HALCON 6.0):

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

s

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted 9C6D4634F08A932DBC2D \
VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=82

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 uncounted \
7CADE63412EF3451B596 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=34

upgrade license file (HALCON 6.0 to HALCON 6.1):

s

# MVTec Software GmbH (ID: 00e02958e3b6) #

B

UPGRADE MVTec_Halcon mvtecd 6.0 6.1 01-jan-0000 uncounted \
3COD76C4ADF2BFE51017 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=54

UPGRADE MVTec_HDevelop mvtecd 6.0 6.1 01-jan-0000 uncounted \
1CCDC6246E6E497BB0B4 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=48

resulting license file after appending the upgrade keys:

B

# MVTec Software GmbH (ID: 00e02958e3b6) #

B s

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 uncounted 9C6D4634F08A932DBC2D \
VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=82

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 uncounted \
7CADE63412EF3451B596 VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=34

UPGRADE MVTec_Halcon mvtecd 6.0 6.1 01-jan-0000 uncounted \
3C0D76C4ADF2BFE51017 VENDOR_STRING=65535 HOSTID=00€02958e3b6 ck=54

UPGRADE MVTec_HDevelop mvtecd 6.0 6.1 01-jan-0000 uncounted \
1CCDC6246E6E497BBOB4 VENDOR_STRING=65535 HOSTID=00e02958e3b6 ck=48

Figure 2.5: Upgrading a license from HALCON 6.0 to HALCON 6.1.

Figures 2.3and2.4 show examples for different types of license files for nodelocked licenses;
an example file for a floating license can be found in the following section. The lines starting
with FEATURE are calledlicense keys As you can see, they contain the version number of
HALCON (in the example files:6.0). However, a license is not exclusively bound to this
release. First, a license dewnward compatible.e., a license for HALCON 6.0 is also valid

for HALCON 5.2. Secondly, a license igoward compatible within a version numbere.,
licenses for HALCON 6.0 are also valid for HALCON 6.0.4. If you upgrade to a newer
version, however, you need corresponding upgrade license figyse 2.5depicts an example

for upgrading a license from HALCON 6.0 to HALCON 6.1.
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2.3.4 Using Floating Licenses

The previous sections already mentioned some issues concerning the use of floating licenses:
First, you must select one computer in your network which is to act asidbese server

i.e., watch over the number of HALCON licenses currently used; on this computer, a special
program called thdicense manager daemanust be installed and started (see the sections
below). Secondly, the license file supplied by your distributor must be copied to all computers
you installed HALCON on, i.e., not only those you want to use HALCON on but also the
license server. Note that if you get a new license, you must restart the license manager daemon
after replacing the license files (sgection 2.3.4.8 The same is true if you modify parts of the
license file.

Let's take a closer look at an example license file fdioating licensein figure 2.6 The line
starting withSERVER tells FLEXIm the name of the host computer acting as the license server
(in the examplethalconserver), its identifying information (in the example: network card
ID), and the port number (in the examplz:000).

If you didn’t send the name of the license server host computer to your distributor when re-
guesting the license, the corresponding field contains the enkwyown; in this case, please
enter the correct host name instead. Another reason for modifying the entry for the host name
is, e.g., if you are using a dongle-bound license and want to switch the dongle (and the license
server) to another computer in your network. The same applies if you change the name of your
host computer or, in the case the license is bound to a network card ID, if you move the network
card to another computer.

You may also customize the port number. This may be necessary for example if the default
port number is used already by another software in your computer network. Note that on many
systems all portsc 1024 are privileged and can only be used by privileged accounts!

Please keep in mind that the information contained in the line starting3RRKMER is used in

two ways: When you start HALCON on an arbitrary computer in your network, it uses the host
name and the port number to locate and contact the license server. On the computer acting as
the license server, the port number is used when starting and configuring the license manager
daemon. Therefore, it is very important that this line is identical in all copies of the license file

in your network!

Depending on where you have installed HALCON on the computer acting as the li-
cense server, you may have to customize the path to the daembscd, which
is in charge of managing the HALCON licenses. Normally, the path will be

HEFH S

# MVTec Software GmbH (ID: 00e02958e3b6) #

HESH

SERVER halconserver 00e02958e3b6 27000

DAEMON mvtecd C:\Progra~1\MVTec\HALCON\FLEX1m\i586-nt4\mvtecd

FEATURE MVTec_Halcon mvtecd 6.0 01-jan-0000 1 1CBD8604021DCIDBC868 \
VENDOR_STRING=65535 ck=43

FEATURE MVTec_HDevelop mvtecd 6.0 01-jan-0000 1 4C2DB644BC603179E58F \
VENDOR_STRING=65535 ck=80

Figure 2.6: Floating license, bound to network card.
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%HALCONROOT%\FLEX1m\%ARCHITECTURE),\mvtecd (Seesection 2.4or information about the
environment variabl@RCHITECTURE). However, since you cannot use environment variables
in the license file, you must supply this path manually. Note that paths including blanks are
not handled properly under Windows NT/2000/XP: Thus, if you have installed HALCON
to a directory likeC:\Program Files\MVTec\HALCON you will have to use the short path
C:\Progra™1\MVTec\HALCON instead. You can query short path names as follows: Open a
Windows Command Prompt, change into the directory that contains the directory or file whose
short name is searched for (hege), and then type

dir /x

Note that the daemomvtecd opens a second port. By default, this port is selected by the
operating system, and thus its number can change. Especially when using a firewall, you might
need to specify the port number explicitly. For this, append the spémrg=numberto the line
starting withDAEMON, for example as follows:

DAEMON mvtecd C:\Progra~1\MVTec\HALCON\FLEX1m\i586-nt4\mvtecd port=28000

Finally, you have to make sure that the license manager daemon is installed and started success-
fully.

2.3.4.1 (Un-)Installing the License Manager Daemon Under Windows
NT/2000/XP

On Windows NT/2000/XP systems, you can let the setup program install the license manager
daemon, which will then be started automatically at boot time as the system service ‘HALCON
Licenses’.

To check whether the daemon was installed successfully, open the Windows dialog show-
ing the state of the installed services. Under Windows NT, this dialog can be opened via
Start > Settings > Control Panel > Services, under Windows 2000 and Windows

XP via Start > Settings > Control Panel > Administrative Tools > Component
Services > Services. If the daemon was installed successfully, the dialog contains the entry
HALCON Licenses

Installing the License Manager Daemon Manually

If you did not install the license manager daemon via the setup, or if its installation failed, you
can install it manually at a later time as described below. Note that you need administrator
privileges for this procedure. Open a Windows Command Prompt, change into the directory
%HALCONROOT%\FLEX1m\1586-nt4, and type ¢nelong command line):

"installs" -n "HALCON Licenses"
-c "JHALCONROOT%\license\license.dat"
-1 "YHALCONROOT%\license\license.log"
-e "%HALCONROOT%\FLEX1m\i586-nt4\1lmgrd.exe"
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with % HALCONROOT), being the HALCON base directory you have chosen during
the installation. For example, if you have installed HALCON in the directory
C:\Program Files\MVTec\HALCON, you type (using quotes to handle paths that contain
blanks)

"installs" -n "HALCON Licenses"
-c "C:\Program Files\MVTec\HALCON\license\license.dat"
-1 "C:\Program Files\MVTec\HALCON\license\license.log"
—-e "C:\Program Files\MVTec\HALCON\FLEX1m\i586-nt4\1lmgrd.exe"

To check whether the installation succeeded, (re-)open the Windows dialog showing the state of
the installed services (see above), which now should contain the¥itepN Licenses (O,

to be more exact, an entry with the name you specified with the opti@n FLEX1m license
manager if you leave out this option).

After the installation, the daemon is not started automatically. If you have administrator privi-
leges, you can start it directly in the dialog by selecting it and then clicking the start button or
icon; if this fails, please check whether the entries in the license file are correct. The license
manager daemon is started automatically whenever you (re-)boot the computer.

Note that if you installed the license manager daemon manually, you must also uninstall, i.e.,
stop it manually before you uninstall HALCON, otherwise it remains installed.

Uninstalling the License Manager Daemon
Please note that for the following procedure you need administrator privileges.

Before you can uninstall the license manager daemon, you must first stop it: Open the Windows
dialog showing the state of the installed services (see above), select theAi@BY Licenses

and then click the stop button or icon. Note that under Windows 2000 and Windows XP an error
message may appear, which can safely be ignored. Now, open a Windows Command Prompt,
change into the directofyHALCONROOT’%,\FLEX1m\1586-nt4, and type:

installs -r —-n "HALCON Licenses"

To check whether the uninstallation succeeded, re-open the services dialog, which should not
contain an entrfiALCON Licenses anymore.

2.3.4.2 Installing the License Manager Daemon Under UNIX

On UNIX systems, the license manager daemegrd must be started from the appro-
priate startup file (called e.g./etc/init.d/boot.local, /sbin/init.d/boot.local,
/etc/rc.boot, /etc/rc.local, or /etc/localrc, please consult your system’s documenta-
tion). Add the following (long) line to this file (with suitable pathlagrd):

/etc/lmgrd -c $HALCONROOT/license/license.dat
> $HALCONROOT/license/license.log 2>&1 &

where$HALCONROOT is the HALCON base directory you have chosen during the installation.
Please note, thaimgrd will only work properly when started withoot privileges!
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2.3.4.3 Restarting the License Manager Daemon

Whenever you replace a floating license or modify it, you must restart the license manager
daemon. One possible method is to reboot the computer acting as the license server. If you
have administrator privileges, you can also restart the daemon manually. On Windows systems,
open the dialog showing the state of the installed services (Windowstakt > Settings

> Control Panel > Services, Windows 2000 and Windows XPStart > Settings

> Control Panel > Administrative Tools > Component Services > Services), Se-

lect the entryHALCON Licenses and then stop and start it again.

On UNIX systems, you stop the procersgrd and then restart it with the line used in the
startup file (sesection 2.3.4.

Another reason for restarting the license manager daemon is when you update to a HALCON
release that uses with a newer version of the FLEXIm license manager software, e.g., from
HALCON 6.0.3t0 6.0.4.

2.3.5 Using a Dongle

Let’s take a closer look at hardware dongles. As already mentioned, you can use dongles for
licensing only under Windows NT/2000/XP. From version 6.0.2 on, HALCON supports not
only dongles connected to the parallel port but also USB dongles. Dongles for the parallel port
have IDs starting with FLEXID=6- or *FLEXID=7-’, while USB dongles have IDs starting

with *FLEXID=9-’. Please note that you cannot use any dongle but only those supplied by
MVTec via your distributor.

2.3.5.1 Dongles for the Parallel Port

As described irsection 2.1.1you can let HALCON install the driver programs necessary for
using dongles. You can check the success of this installation in the following system dialog,
which should contain an entry call€dntinel.

e Windows NT : Start > Settings > Control Panel > Devices.

e Windows 2000, Windows XP: Start > Programs > Accessories > System Tools
> System Info > Software Environment, then selecDrivers under Windows 2000
or System Drivers under Windows XP, respectively.

You can install, configure, and uninstall the dongle driver manually using an auxiliary program
which is part of each HALCON installation. Open a Windows Command Prompt or the dialog
Start > Run and start the program

%HALCONROOT%\FLEX1m\i586-nt4\flexid6-7\win_nt\setupx86.exe

To install the driver, select the menu iteéfanctions > Install. Afterwards, reboot your
computer. Then, the driver should appear in the dialog described aBease note, that you
need administrator privileges to install the driver! If you try to install the driver without ad-
ministrator privileges, the setup program might falsely state that the installation was successful.
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You might need to configure the driver if your computer has more than one parallel port.

Note that the HALCON uninstallation process does not uninstall the dongle driver as it
might also be used by another application. The uninstallation removes the auxiliary pro-
gram, though. Therefore, if you want to uninstall the driver, do so before uninstalling
HALCON; of course, the program can still be found on the HALCON CD in the directory
FLEX1m\i1586-nt4\flexid6-7\win_nt.

Special Information for HALCON 6.0.2 or higher

As already mentioned isections 2.1.Z2nd 2.2.1, you must pay special attention to the don-
gle driver when installing HALCON 6.0.2 or higher versions. We recommend the following
procedure:

e Uninstall the old driver manually; the corresponding auxiliary progestupx86 . exe
can be found in the directoffHALCONROOT?,\FLEX1m\i586-nt4\dongle.

e Now there are two ways to install HALCON 6.0.2 (or higher versions):

e Uninstall your old HALCON version as describedsaction 2.2.1then install HAL-
CON 6.0.2 (or a higher version) together with the new dongle driver as described in
section 2.1.1

e Use the update mechanism describedention 2.1.3in this case you must install
the dongle driver manually afterwards with the auxiliary prograsupx86. exe
located in the director§{HALCONROOT%\FLEX1m\1586-nt4\flexid6-7\win_nt.

If you uninstalled HALCON before uninstalling the old driver, the corresponding auxiliary
program will be removed! You can recover it from a HALCON 6.0 CD (in the directory
FLEX1m\i586-nt4\dongle); if you don’t have a CD, we recommend to install your old HAL-
CON version again.

2.3.5.2 Dongles for the USB Port

As described irsection 2.1.1you can let HALCON install the driver programs necessary for
using dongles.  You can check the success of this installation in the system dialog given in
section 2.3.5.lwhich should contain two entries callgdrdlock andHASP (or similar).

Depending on your operating system, you can install, configure, and uninstall the dongle
drivers manually using an auxiliary program which is part of each HALCON installation.
Open a Windows Command Prompt or the diakgart > Run and execute the program
JHALCONROOT’%\FLEX1m\1586-nt4\flexid9\hinstall.exe in one of the following ways:

hinstall opens a dialog explaining how to use hinstall
hinstall -info shows the status of the drivers

hinstall -i installs the drivers

hinstall -remove removes the drivers

Please note that you need administrator privileges to install the drivers!

HALCON 6.0.4



26 CHAPTER 2. INSTALLATION, LICENSING, CONFIGURATION

Note that the HALCON uninstallation process does not uninstall the dongle drivers as they
might also be used by another application. The uninstallation removes the auxiliary pro-
gram, though. Therefore, if you want to uninstall the drivers, do so before uninstalling
HALCON; of course, the program can still be found on the HALCON CD in the directory
FLEX1m\i586-nt4\flexid9.

2.4 Configuration

Most of the configuration necessary to work with HALCON amounts to setting environment
variables, e.g., to tell HALCON the directories where to find images or extension packages etc.
These environment variables are described below. To work with Parallel HALCON, you need
to initialize it once on each computer it is to be used on. This is describsection 5.1.1

2.4.1 Configuring HALCON Under Windows NT/2000/XP

The installation programSetup.exe automatically sets the necessary environment variables,
e.g., »HALCONROOT?, %HALCONIMAGESY, and’HALCONEXTENSIONSY (see below). To take a
look at these setting, open the dialégart > Settings > Control Panel > System and
selectEnvironment. You can add or modify a variable by entering the name of a variable
and the desired value. If a value consists of multiple items, as e.g. the vé{rai), which

may contain multiple directories, those items must be separatesgmycolons Please note
that in order to modify variables set during the HALCON installation you need administrator
privileges!

e HALCONROOT
This is the most important environment variable. It designates the directory, where HAL-
CON is installed. A typical path is, for example; \Program Files\MVTec\HALCON.
According to this variable, the system switches to subdirectories, which are important for
running HALCON. Some of them are:

- %HALCONROOT%\help
The operator data base is situated in this directory. It is accessible by all HALCON
programs to obtain information about HALCON operators.

- %HALCONROOT\doc\html\reference\hdevelop
HDevelop uses this directory for online help which can be displayed by a suitable
HTML browser like Netscape Communicator.

- %HALCONROOT%\1ut
User defined look-up tables are situated in this directory.

- J%HALCONROOT?%\ocr
This directory includes trained fonts.

- %HALCONROOT%\license
This directory contains the license keys necessary for using HALCON.

- %HALCONROOT%\images
If the variableHALCONIMAGES (see below) is not set the system looks for image files
in this directory.
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e HALCONIMAGES
To search for image files specified by a relative path, the system uses this environment
variable. As a rule it contains several directory names, possibly including the CD ROM,
separated by semicolons.

e ARCHITECTURE
HALCON uses this variable to differentiate between the supported platforms (operating
systems). On a Windows NT/2000/XP systeéfaRCHITECTUREY, iS set t0i586-ntA4.
The variable appears in different directory paths: Executable HALCON programs, e.g.
hdevelop.exe, and DLLs, e.ghalcon.dl1l, reside in,HALCONROOT/\bin\1586-nt4.
During installation, this path is automatically added to the environment vaRaie(see
below). The libraries which you need for linking programs, @4j.con.1ib reside in the
directory,HALCONROOT%\1ib\i586-nt4.

e HALCONEXTENSIONS
This is a list of directories in which user-defined extension operators (so-called exten-
sion packages) are kept. Each package consists of a number of operators linked into
a shared library, plus the additional operator documentation in help-files and HTML
files. Seesection 2.5for information on how to install an extension package, and the
Extension Package Programmer’s Manualfor details on creating your own extension
packages.

e HALCONSPY
If this environment variable is defined (regardless of the vabeéyre you startr HAL-
CON program, the HALCON debugging tool HALCON Spy is activated. This corre-
sponds to call the HALCON operatset_spy with the parametersmode", "on" withina
HALCON program. The main difference between the two modes for activating HALCON
Spy is that by defininHALCONSPYY it is possible to monitor an already linked HALCON
program during runtime without modifications. For further information on how to use
HALCON Spy and how to parameterize it via this environment variable please refer to
section 6.4

e PATH
During the installation, the directories);HALCONROOT’\bin\i586-nt4 and
JHALCONROOT’%\FLEX1m\i586-nt4 are automatically added to the system variable
PATH.

Please take a look at the fitelease notes.html within the HALCON package for the latest
information.

2.4.2 Configuring HALCON Under UNIX

Under UNIX, different shells offer different commands to set environment variables, e.g.,
setenv <variable> <value> Or export <variable>=<value>. Please consult your
shell's documentation for further information. If a value consists of multiple items, those items
must be separated laplons

Below, you find a list of environment variables used by the HALCON library and by HDe-
velop. We recommend to set them iogin scriptor ashell resource scripte.g., . cshrc or
.profile):
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Examples for entries incshrc
setenv HALCONROOT /usr/local/halcon
setenv ARCHITECTURE i586-1inux2.2
setenv PATH ... :$HALCONROOT/bin/$ARCHITECTURE/: . ..
setenv LD_LIBRARY_PATH ...:$HALCONROOT/1ib/$ARCHITECTURE/: ...
setenv HALCONIMAGES $HALCONROQOT/images

e HALCONROOT
This is the most important environment variable. It designates the directory, where HAL-
CON is installed. Typical paths are, for examplesr/local/halcon Or /usr/halcon.
According to this variable the system switches to subdirectories, which are important for
running HALCON. Some of them are:

- $HALCONROOT/help
The operator data base is situated in this directory. It is accessible by all HALCON
programs to obtain information about HALCON operators.

- $HALCONROOT/doc/html/reference/hdevelop
HDevelop uses this directory for online help which can be displayed by a suitable
HTML browser like Netscape.

- $HALCONROOT/1lut
User defined look-up tables are situated in this directory.

- $HALCONROOT/ocr
This directory includes trained fonts.

- $HALCONROOT/license
This directory contains the license keys necessary for using HALCON.

- $HALCONROOT/images
If the variableHALCONIMAGES (see below) is not set the system looks for image files
in this directory.

e HALCONIMAGES
To search for image files specified by a relative path, the system uses this environment
variable. As a rule it contains several directory names separated by colons on UNIX
systems.

e ARCHITECTURE
This variable designates the used platform by an abbreviation (€&g§6-1inux2.2
or sparc-sun-solaris7; itS syntax is:processothardwarevendoroperatingsystem
ARCHITECTURE appears in several directory paths: Executable HALCON programs, e.g.
hdevelop, reside in$HALCONROOT/bin/$ARCHITECTURE. It is therefore useful to in-
clude the pati$HALCONROOT/bin/$ARCHITECTURE in the environment variableATH of a
shell script. Shared libraries reside in the direct®ifL.CONROOT/1ib/$ARCHITECTURE.
Table 2.1gives an overview of the currently supported UNIX platforms and the corre-
sponding values ofRCHITECTURE.

e PATH
If you want to start HDevelop from an arbitrary directory, you must include the HALCON
program pati$HALCONROOT/bin/$ARCHITECTURE in the system variablBATH.

Sformerly called DIGITAL UNIX
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ARCHITECTURE Operating System (Platform) Compiler
1586-1inux2.2 Linux 2.2/2.4 on Intel Pentium (or compatible)| gcc 2.95
sparc-sun-solaris7 | Solaris 7 on Sparc Workstations CC 5.2
mips-sgi-irix6.5 IRIX 6.5 on SGI Workstations (Mips processorsgc
alpha-compag-osf5.1 | Tru64 UNIX 5.1° on Alpha processors CXX

Table 2.1: Values of ARCHITECTURE for the currently supported UNIX platforms.

e [D LIBRARY PATH
Please include the HALCON library pa#HALCONROOT/1ib/$ARCHITECTURE in the
system variabl&D_LIBRARY_PATH. This is necessary both for running HDevelop and for
creating stand-alone applications.

e HALCONEXTENSIONS
This is a list of directories in which user-defined extension operators (so-called pack-
ages) are kept. Each package consists of a number of operators linked into a
shared library, plus the additional operator documentation in help-files and HTML
files. Seesection 2.5for information on how to install an extension package, and the
Extension Package Programmer’s Manualfor details on creating your own extension
packages.

e HALCONSPY
If this environment variable is defined (regardless of the vabeédre you startr HAL-
CON program, the HALCON debugging tool HALCON Spy is activated. This corre-
sponds to call the HALCON operateet_spy with the parametersmode", "on" withina
HALCON program. The main difference between the two modes for activating HALCON
Spy is that by defininHALCONSPY?, it is possible to monitor an already linked HALCON
program during runtime without modifications. For further information on how to use
HALCON Spy and how to parameterize it via this environment variable please refer to
section 6.4

e DISPLAY
The system uses this environment variable to open windows. It is used in the same way as
for other X applications.

e HOME
This system variable points to your home directory. In Parallel HALCON 6.0
beta, the operatotheck par hw potential which initializes Parallel HALCON (see
section 5.1.] saved the extracted information about the host computer in the file
$HOME/ .halcon_par_info .

2.5 Integrating a HALCON Extension Package

The HALCON Extension Package Interface allows to integrate newly developed image process-
ing algorithms into HALCON in the form of so-callezktension packaged he same mecha-

nism is used by MVTec to extend the current HALCON release with additional functionality.
Which extensions packages are currently available can be checked by selecting HDevelop’s
menu entryHelp > HALCON News (WWW), which connects to MVTec's WWW server.

HALCON 6.0.4



30 CHAPTER 2. INSTALLATION, LICENSING, CONFIGURATION

This section describes how to integrate a (downloaded) package in order to use it within your
HALCON system.

2.5.1 Installing an Extension Package

First, move the package to the directdfyALCONROOTY, and unpack it there. Then, add the
completepath of the package, e.g.,

J:HALCONROOT? \packages\halconuser

to the environment variabBALCONEXTENSIONS. Note that the delimiter between paths in an
environment variable is a semicolon on Windows systems and a colon on UNIX systems.

Never change the name of a package or the corresponding names of the li-
braries or DLLs contained in a package.

These names are encodeihin the libraries/DLLs. If you change the names this information
will not match any longer. Thus, the loader of the operating system will fail to open the dynamic
libraries.

If the package contains images used, e.g., within example programs you might want to in-
clude the corresponding directofynages within the package in the environment variable
HALCONIMAGES (seesection 2.4to access those images without specifying a complete path.

2.5.2 Using an Extension Package Within HDevelop

In order to use a new package within HDevelop under Windows NT/2000/XP, Solaris, IRIX, or
Tru64 UNIX/ DIGITAL UNIX, you just have torestart the program. HDevelop automatically
integrates all extension packages specifiediAlCONEXTENSIONS, i.e., the operators contained

in a package can be accessed and used like any other HALCON operator.

Under Linux, you have to include the package library subdirectoby 1586-1inux2.2 in the
environment variableéD_LIBRARY_PATH before starting HDevelop the first time.

2.5.3 Using an Extension Package in a Stand-Alone Application

If you want to generate a stand-alone application using the package you have to link package
libraries (DLLs under Windows, shared libraries under UNIX) to the application code (besides
the standard HALCON library, of course).
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2.5.3.1 Using an Extension Package Under Windows NT/2000/XP

In order to create new application programs (written in C or C++) you have to link
packagec.lib Orpackagecpp.lib to your objects. Furthermore, you will needlconc.1lib
orhalconcpp.lib (as for any HALCON application).

To be able to link the package DLL to your application programcttrapleteDLL file path of
the new package, e.g.,

%HALCONROOT%\packages\halconuser\bin\i586-nt4
has to be added to the environment vari&ieH.

Do not copy a package DLL into the Windows system directoriesas it would be loaded
twice in this case!

2.5.3.2 Using an Extension Package Under Linux

In order to create new application programs (written in C or C++) you have to link
libpackage.so and libpackagec.so Or libpackagecpp.so t0o your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdiredtisyi586-1inux2.2 to the
environment variableD_LIBRARY_PATH, otherwise the loader will fail to access the libraries.

2.5.3.3 Using an Extension Package Under Solaris

In order to create new application programs (written in C or C++) you have to link
libpackage.so and libpackagec.so Or libpackagecpp.so to your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdireatbsysparc-sun-solaris7
to the environment variableD_LIBRARY_PATH , otherwise the loader will fail to access the
libraries.

2.5.3.4 Using an Extension Package Under IRIX

In order to create new application programs (written in C or C++) you have to link
libpackage.so and libpackagec.so Or libpackagecpp.so to your objects (besides
libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).

Furthermore, you have to add the package library subdirettarymips-sgi-irix6.5 to the
environment variableD_LIBRARY_PATH, otherwise the loader will fail to access the libraries.

2.5.3.5 Using an Extension Package Under Tru64 UNIX (DIGITAL UNIX)
In order to create new application programs (written in C or C++) you have to link
libpackage.so and libpackagec.so Or libpackagecpp.so t0 your objects (besides

libhalcon.so andlibhalconc.so Or libhalconcpp.so as for any HALCON application).
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Furthermore, you have to add the package library subdire¢tisyalpha-compagq-osf5.1
to the environment variableD_LIBRARY_PATH, otherwise the loader will fail to access the li-
braries.
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Chapter 3

A First Look at HDevelop

In this chapter you will learn how to solve an image analysis problem from the scratch. Dur-
ing an example session the most important features of HDevelop are going to be introduced.
You will become familiar with HDevelop'graphical user interface (GUland learn to use it
efficiently.

The example is chosen from the domain of quality control. The goal is to detdxzlbiond-
ingson adie, seefigure 3.1 The HDevelop program corresponding to the example session is
included in the HALCON package subdirectory:

%HALCONROOT%\examples\hdevelop\Manuals\GettingStarted\example.dev
In particular it will be shown

e how to construct a HDevelop program with HALCON operators,
e how to find suitable operators and parameter values,

¢ how to handle iconic and control variables,

e how to handle the graphics window,

e how to generate a region of interest (ROI),

e how to solve the example problem using morphology,

e how to solve the example problem by pattern matching, and

e how to use control constructs.

Read this chapter very carefully and you will understand the basic interactive features of HDe-
velop. This will help you to develop your own sophisticated image analysis programs in the
future.
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Figure 3.1: The image to be analyzed: All ball bondings on a die have to be detected.

3.1 The Graphical User Interface of HDevelop

You start HDevelop under Windows NT/2000/XP by calling
Start > Programs > MVTec HALCON > HDevelop

Under UNIX, HDevelop is started from the shell by calling
hdevelop

Having started HDevelop, the main window will appear on your screen. It containsvidns
dows (sedigure 3.9

e a program window,
e an operator window,
e avariable window, and

e a graphics window.

In the following, the HDevelop windows will be explained briefly. For more details see the
HDevelop User’s Manual.

3.1.1 Main window

Themain windowis the central window and the starting point for your work. It comprises the
creation of a program (operator selection, editing, etc.) and the session management (loading,
saving, etc.). This main window is identified by the title 'HDevelop’ in the window’s title bar.

It also contains anenu barand atool bar.

Please note that in the UNIX environment the main window, the program window, and the operator window
are combined into one window. Thus, there are dhigewindows.
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Figure 3.2: The main window.

e Main window menus
In these menus you will find the complete HDevelop functionality, which is summarized
in the following table. For more detailed information see the HDevelop User’'s Manual.

Menu Contains Commands for:
File Loading and saving of HDevelop programs and exit-
ing HDevelop
Edit Editing a HDevelop program
Execute Running a HDevelop program

Visualization| Customizing the graphics windows and handling their
output behaviour

Operators Submenus containing programming constructs, HDe-
velop operators, and all HALCON operators

Suggestions | Support choosing an operator
Window Window management
Help Opening online documentation and guides

e Main window tool bar
This tool bar offers shortcuts for frequently used commands. Furthermore, it provides the
means to control the execution of an HDevelop program.
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Button Performs this Operation:
New Deletes the current program in the program window
Open Opens a new HDevelop program
Save Saves a HDevelop program
Cut Deletes program lines selected in the program window
Copy Copies program lines selected in the program window
Paste Inserts copied lines in the program window
Run Executes the HDevelop program
Step Executes the next command of the HDevelop program
Stop Stops the running HDevelop program
Activate Activates the lines selected in the program
Deactivate Deactivates the lines selected in the program
Reset Resets the program into its initial state and clears all varialbles
Set parameters Opens the visualization parameter dialog window
Pixel info Opens the pixel info window
Zooming Opens the online zooming window
Gray histogram infg Opens the interactive gray histogram inspection window
Region info Opens the interactive region feature inspection window

3.1.2 Program Window

This window is used to display a HDevelop program. This might be an entire program, which
has been loaded, or single operators only. It has two parts: The left area contains marks which
control the running of a HDevelop program. In the initial HDevelop state you will see the
program countefPC), represented by a green arrow, anditisertion cursoy represented by a

. Additionally you may set &reak pointduring program debugging (see the user HDevelop
User’s Manual for a detailed explanation). The right area contains the program code. Itis empty
in the initial state.

3.1.3 Operator Window

This window will show you important information about a chosen operator. It indicates all
parameter names, their types, and their values. It supports you in specifying a parameter value
by displaying a default value and alternative values. Additionally, you may get online help for
each operator.

Another window element is the text field. If you are not quite sure about an operator name
you may specify a substring in this text field. In this case, the system is going to search for all
operators in its operator base which include this substring. They are displayednmo@ box
where you may choose the appropriate operator.

3.1.4 Variable Window

This is the control unit for variables generated during the execution of the program. Double-
click on a variable to display its value. If the variable corresponds to an image or a set of regions
(iconic variablg, the contained objects are displayed in the Graphics Window.
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3.1.5 Graphics Window

This window is used to display iconic variables. The visualization modes can be adapted to your
needs with the functions provided in tiésualization menu. You may open an arbitrary
number of graphics windows. Each window can be activated interactively or accessed using its
specific window ID.

3.2 Editing a HDevelop Program

After starting HDevelop, the tool waits for your input. You create an application, in other words,
write your HDevelop program, by adding lines in the Program Window. To add a new line,
i.e., a new operator, you have to perform two steps:

¢ Position thensertion curson> on the appropriate line of the program where you would
like to insert the new line. This cursor is placed by pressing#ie £t> button on your
keyboard and clicking in the left column beside of the program line with the left mouse
button.

e Select the new operator using thperator menu or type its name in theperator
window’stext field.

Now the new operator is displayed in thperator window Provide or adapt the input parame-
ters and — if desired — change the names of the output variables. Therkxtiek to insert

the operator as a new program line. If you click@xninstead, the operator is not only inserted,

but also executed immediately. Finally, if you click apply the operator is not inserted into

the program, but only executed. This allows you to test the effect of your parameter settings
very quickly and conveniently.

To execute an arbitrary line of a HALCON program you have to positioptbgram counter
(PC) at this line (just click at the left column beside the line). Then presstlee icon in the
main window tool bar. If you presiun instead all subsequent lines will be executed until a
breakpoint or astop command is encountered. A single-click on a program line selects this
line, a double-click transfers the line back to the operator window.

Once you have finished the program you can save it and load it again later, or you might export
itas C, C-+, or COM code to generate a standalone applicationfsee > Save as. . .).

These basic steps will be used many times during the example session. So you will have many
opportunities to get used to the different methods of editing program, specifying parameter
values, etc. For now, just continue with applying your first operator to read an image.

3.3 Loading an Image

First of all, you have to create a HALCON object that contains yoput image You may
obtain an image in several ways:

°The Copy, Cut, andPaste commands, which are also very convenient to edit a HDevelop program, will be
explained later during this session.
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Figure 3.3: Setting the parameters of the operator read_image.

e You can use a frame grabber to obtain an online image (see menwgertors >
Image > Framegrabber).

e You can read animage from a file (see menu i®@@rators > File > Images and menu
itemFile > Read image...).

e You can create a new image (see menu il@erators > Image > Creation).

In the example we will use theead_image operator. Just seleetad_image in the submenu
Operators > File > Images Or typeread_image in theoperator window'sext field and press
Enter. Now the operator should be displayed in th@erator window seefigure 3.3 The

first parameter is thenage objectyou are about to create. Change the default name of the
corresponding variable to 'Die’. You get a text field focus by clicking the left mouse button
inside the desired text field. The second parameter is the name iofidige file Change it to
'die3’:

read_image (Die,’die3’)

Having specified all parameters you should pist transfer the operator to tipgogram win-
dowand to execute it. Now you have created the first line of your program iprégram win-

dow. The variablédie containing the image object you just created is displayed indhni@ble

window Simultaneously, the result of the operator (in this case the original image) is displayed
in thegraphics window If you encounter an error trying to load the image, check whether your
environment is set up correctly. The image should be locatédAhCONROOTY,\ images which

is also the default search path for image files as long as you do not provide specific search paths
in theHALCONIMAGES variable, sesection 2.4
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3.4 Modifying the Graphics Window

The size of the initial graphics window is 522512 pixels. If your image is bigger or smaller
than this size it will therefore be displayed distortedly. You can interactively change the win-
dow size just by picking the lower right corner with the mouse, but the easiest way to see the
undistorted image is to seletisualization > Size Window > Original. This enlarges or
shrinks the window to the size of the most recently displayed image. However, in this example
we are going to open a new window with the proper size because we will need its window han-
dle later on. Again, there is a interactive way to do this (see rieaualization), but we will

use the HDevelop operataev_open _window instead to include this task in the program itself.
HDevelop operators are handled in the same way as HALCON operators. You can access them
via the menwperators > HDevelop or directly via theoperator window’stext field. The
parameteiidth andHeight specify the size of the window. If you do not know the size of
the current image you just specify -1’ for both parameters. In that case the size of the most
recently created image will be used.

dev_open_window (0,0,-1,-1,’black’,WindowID)

Click on 0k and a newgraphics windowappears. It has the same size as your image. But the
new graphics display remains dark. It is now #etive graphics windovand waits for your
input. It is up to you what to display in this window. Double-click on tbenic variableDie

in thevariable windowby using the left mouse button in order to display this image. Now you
see the input image without distortion, degire 3.1

The default visualization for an image is to display the image matrix, i.e., the gray (or color)
value of each pixel. You can easily switch to other visualization mode¥idaalization

> Set parameters... > paint. Choose for example '3D-plot’ and seldfjidate to see a

3D plot of the image. The various visualization modes are described in detail in the HDevelop
Users Manual. Do not forget to change the mode back to 'default’ before continuing with the
example session. All the visualization modes can be modified within your program as well: For
example, the display of the histogram is activatediby_set_paint (’3D-plot’). See also
section 3.50 learn how to manipulate the visualization of regions.

Furthermore, it is possible to zoom into the image. Just select the menuitemlization

> Set parameters... > zoom. Click on the uppelnteractive... button. Now you can
specify a rectangle within your graphics window. To do this you press the left mouse button to
indicate the upper left corner. Keep the button pressed and drag the mouse to the lower right
corner of the desired rectangle. Release the left button and click the right button once. Now
you have specified the image part you are interested in. All visualizations are now zoomed to
this image part. This is the interactive way to set an image part. Another possibility is the direct
input of the coordinates of the image part {itsualization > Set parameters... > zoom

or to use the HDevelop operataev_set_part). To visualize the whole image again, click
Reset in Visualization > Set parameters... > zoom.

3.5 Creating a Region of Interest (ROI)

Very often it is useful to specify a ROl which is used in the following processing steps. By re-
stricting the image domain the performance can be increased significantly because all following
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image processing tasks will be performed only within this ROl and not on the whole image.

Figure 3.4: A rectangular and an arbitrary region of interest (ROI).

To generate a ROI you have the following possibilities:

¢ Interactive creation of a rectangular ROI:
Select the operatdiraw_rectanglel from the menWperators > Graphics > Drawing
to draw a rectangle in thgraphics window Just execute the operator with the default
names for the output variables (containing the pixel coordinates of the upper left and
lower right corner of the rectangle). This creates a new line irptbgram windowand
HDevelop waits for you to draw the rectangle (like you did before while setting an image
part to zoom in). After you finished the drawing, the four control output variaties,
Columni, Row2, andColumn? will appear in thevariable window seefigure 3.5 To gen-
erate the corresponding ROI as an HALCON object, use the opgraiorectanglel
from the menwperator > Regions > Creation with the variableRowl — Column2
as input parameters. You might use 'ROI’ as the name for the resulting output object:

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

By executing this operator you create another type of HALCON object — a region, see
section 4.2.3

i Variable Watch |_ (O] x]

Iconic ariahles:

Contral Yariahles:

WindowHandle: 3604
Rowl: 975

Column1: 2955
Riow2: 0645
Colurn2: G655

«| | »

Figure 3.5: The variable window containing iconic and control variables.
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The default visualization for a region is the shape of the region (here the rectangle)
drawn with the current color into thgraphics window You may manipulate this
graphics output by choosing items of the mehisualization or executing the cor-
responding HDevelop operatdev_x. For example, set the drawing color to 'green’
with Visualization > Color, increase the line with for drawing to 3 pixels with
Visualization > Line Width and specify, that only the region boundary ('margin’)
instead of the whole region (fill') should be displayed withsualization > Draw.

Each time you change the visualization, the last iconic object that was drawn into the
currently active graphics window is redisplaydigre 3.4. Therefore, you need only
redisplay an object by hand (by double-clicking it in tregiables windowf you want to
change the display mode of an “older” object.

e Interactive creation of an arbitrary ROI:
HALCON supports arbitrary regions as ROI, d&pire 3.4 Just uselraw_region from
the menwperators > Graphics > Drawing instead of the sequendeaw_rectanglel
andgen_rectanglel:

draw_region (ROI, WindowID)

To adapt the program in this way, you may select the din@w_rectanglel (just click
on that line) and deactivate it withdit > Deactivate. Do the same with the line
gen_rectanglel.

e Computation of a suitable ROI:
The computation of a suitable ROI based on intermediate results of the image analysis is
the most challenging but also the most flexible approach. In our example we will detect
the board itself and use this as a ROI for the ball detectionseeton 3.8

Once you have generated a ROI you can reduce the image domain to this region with the oper-
atorreduce_domain from Operators > Image > Domain. SpecifyDie as inputimage ane0I
as input region:

reduce_domain (Die, ROI, ImageReduced)
mean_image (ImageReduced, ImageMean, 11, 11)

The resulting imagé&mageReduced is only defined within the ROI. Clear the window and
double-click on the variablémageReduced to see this effect. You might apply a couple of
operators to the original image and the reduced image to see the increase in performance. For
example, trymean_image from Operators > Filter > Smoothing with Die as input image.

Then clear the window and double-click on thean_image program line to change the input
image toImageReduced.

To repeat the above sequence with different ROIs just plac®then draw_rectangle or
draw_region (depending on which method you have activated) and &ssln order to stop
the execution of the program before a specific operator is applied, plaeala point (BP)n
the program line containing this operat@ofitrol key and mouse click in the left column).
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3.6 Finding the Right Operator

You have created your first HALCON object — the original image. But how to continue? There
are about 900 operators to choose from. Naturally, the selection of a suitable operator sequence
depends on the image analysis task you have to solve. In general, it is up to your experience
and image analysis knowledge to make the right selection. However, HDevelop supports you in
many ways during this program development.

The HALCON operators are hierarchically structured. Just browsegéeators menu to get
a first impression.

i Dperator =] E3
Operstar: [thresh| d
auto_threshold
hin_threshold -
char_threshold ¥ | (mage / object)
dual_threshold
dyn_threshold - | [region ! okject]
fast_threshold
hls‘to_m_.thrash ﬁ Crimber { real)
hysteresis_threshold
threshold
threshold_sub_pix = | (umber /redl)
(o113 I Enter Apply | Cancel | Help |
=
) | ]

Figure 3.6: Selecting the threshold operator using the substring “thresh”.

Again, if you already know at least a substring of the operator name you might also just type
this string in theoperator window'dext field. If there is an ambiguity, you choose the operator
inside thecombo boxseefigure 3.6

For each HALCON operator the HDevelamline helpprovides an HTML description. Just
selectHelp > HTML. . . to start your default browser. You will see the table of contents of alll
image analysis modules — structured in the same way a@pwators menu. Simply select

an appropriate chapter and continue browsing until you find your operator. There are also many
cross references according to the relationships between the operators. At the end of the main
page there is an index of all operators, which helps you to jump directly to a specific operator
HTML page.

Furthermore, the mensuggestions > Keywords offers access to HALCON operators by
keywords By selecting this menu item, a window is displayed with the available keywords on
the left side and the operators related to the selected keywords on the right side. If you select
a keyword using your mouse you will see the corresponding operators in the right area. Each
mouse click in the left area marks the keyword and adds some operators in the right area. To
finally select an operator and display it in thperator windowust click on the operator name
using your left mouse button.

Once you have selected one of the operatorsdéel_image in our example, you can enquire
information related to this operator from tbperator knowledge base

e The HTML online help.
Just click on thédelp button to launch your default web browser and get the complete
online documentation of the selected operator.

Getting Started with HALCON, 2003-08-01



3.7. FINDING THE RIGHT PARAMETER VALUES 43

e Suggestions > Alternatives
If an intermediate result does not fulfill your requirements you might want to choose an
alternative operator which might be more suitable for your task. Note, that in many situ-
ations there is a trade off between performance and accuracy of the results. For example,
you might use the high performance smoothing fitiesn_image in one situation and the
higher quality smoothing filtergauss_image or smooth_image in another.

e Suggestions > See also
The online help of HDevelop also offers references to other operators, which are not
exactly alternatives, but related to the current operator in some way. For example, if you
currently look atread_image you might be interested in therite_image operator as
well.

e Suggestions > Predecessor
Many operators require a specific input provided by other operators. For example, before
computing junction points in a skeletojufactions_skeleton), you have to compute
the skeleton itselfdkeleton).

e Suggestions > Successor
On the other hand, there are typical sequences of operators. Hence HDevelop suggests
some reasonable operators to be executed following the operator you are currently looking
at. For example, thresholding might be a good idea after applying an edge filter.

In our example you have just created the input image. Naturally, this is a very unspecific sit-
uation with lots of different opportunities to continue. However, we will accept one of the
successor suggestions, tttereshold operator later on.

3.7 Finding the Right Parameter Values

Once you have selected an operator (from the menu, by typing it's name, or by double-clicking
on a program line in the program window), it is displayed in diperator window Now you

have to specify the parameters for the operator. Of course, you can type in every parameter
manually (either a control value or a variable name). In many cases it is more convenient to
use thecombo boxesgclick on the arrow at the right side of the parameter field) instead, which
provide a listing of meaningful values or names of variables you specified within your program.
Furthermore, for control input parameters default values are provided by HDevelop.

For example, apply threshold operatoto the inputimage by selecting the operatbreshold

from Operators > Segmentation. Specify the input imageie using thecombo box If you

use the default values for the lower and upper threshold, all pixels in the input imaggrayth
valueslarger than 128 will be included in the resulting output region. Therefore, you could call
the corresponding output varialBeightRegion. It might be helpful to set the visualization
modeVisualization > Draw to ‘fill'. In this case you see all the selected image pixels painted
in the current drawing color in thgraphics window Double-click onDie andBrightRegion
again to underlay the visualization of the region with the original imagefigers 3.7

To choose another parameter value just double-click on the program line containing the cor-
responding operator, change the parameter, and ppgds. The operator will be executed
immediately and its result will be visualized. Repeat this process until you are satisfied with the
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Figure 3.7: The region object BrightRegion containing all pixels with gray values larger or
equal 128.

result, then presgk. But remember to clear the window or underlay the original image before
each new execution of an operator returning a region. Otherwise, you only see the accumulated
visualization of all regions you generate during the parameter tuning.

3.8 Finding the Board as ROI

Looking at the input imag®ie you will notice that the surface of the board is quite bright.
Thus, by applying thehreshold operator with the default values 128 and 255, a reasonable
raw segmentatioof the board can be achieved. We will now transform this segmentation
into aregion of interestfor the ball detection: Select the HALCON operatdtape_trans

with BrightRegion (the result of the thresholding) as input region and 'rectangle2’ as value
for the parameter 'type’ to obtain tremallest rectangléof arbitrary orientation) containing
BrightRegion. The resulting region (called ‘ROI’) is a reasonable approximation of the board
in the image. As irsection 3.5reduce the domain of the original image to this ROI with the
reduce_domain operator:

threshold (Die, BrightRegion, 128, 255)

shape_trans (BrightRegion, ROI, ’rectangle2’)
reduce_domain (Die, ROI, DieROI)

The following computations will be performed only on the resulting imag€eR0I within the
board.

3.9 Finding Bonding Balls Using Morphology

If you look closer at your image you will notice that the bonding balls to detect are darker
than thedie itself. Therefore, anotheéhresholdingmight be suitable as the next operation, see
figure 3.8 Due to noise, the resulting region (all the dark parts within the board) might have
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Figure 3.8: The region object RawSegmentation containing all dark pixels within the board.

some small holes which can obstruct further processing. For a controlled filling up of these arti-
facts, the HALCON operatafill_up_shape (in Operators > Regions > Transformation)
is suitable.

threshold (DieROI, RawSegmentation, 0, 50)
f£ill_up_shape (RawSegmentation, Wires, ’area’, 1, 100)

Visualize the variablegires andRawSegmentation, then change the drawing color to see the
difference.

Figure 3.9: Removing faulty parts of the raw segmentation with the opening_circle operation.

Unfortunately, the region found so far contains not only the bonding balls but also some darker
areas, especially the wires connected to the balls. Obviously, the bonding balls have a circular
shape. We use this information to separate the bonding balls from the other dark parts by
using the HALCON operataspening circle (in Operators > Morphology > Region). This
morphological operation will suppress all parts of the region, where the underlying structural
element — a circle with a specific radius — does not fit within the regionfigeee 3.9
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opening_circle (Wires, BallRegion, 15.5)

Visualize the variableBires andBallRegion, then change the drawing color to see the effect
of this operation.

Now there is only one artifact left in the segmentation: A large dark rectangular shape, in
which the circular mask for the opening has fitted as well. In order to eliminate this error the
intermediate result — the regiddallRegion — is separated into connected regions via the
HALCON operatorconnection:

connection (BallRegion, Balls)

Note the differenceBallRegion iS one region containing all the pixels of the segmentation
so far. The different parts of this region are not connected, but still they form a single region.
Balls is a variable containing seven separated HALCON objects — one per connected region.
SetVisualization > Colored to 12. Now 12 different colors are used cyclically to paint the
region objects. It is a very convenient feature of the HALCON system that iconic variables can
contain not only single objects, but also tuples of objects. Most HALCON operators accept
such tuples as input and perform their task simultanously on all the contained objects. Due
to this mechanism you won’t have to program loops to process objects one by one in most
situations.

Based on the circular shape of balls, the elimination of the rectangular region is now very
simple. Just apply theelect_shape operator (inOperators > Regions > Features) with
‘circularity’ as the selection criterion:

select_shape (Balls, FinalBalls, ’circularity’, ’and’, 0.85, 1.0)

Double-click on the variableie, then onFinalBalls to see the selected regions only. Note
again thaBalls contains seven objects, from which you select all circular regions with this
single operator call. Now, the ball segmentation is finished. In the next section it will be shown
how to perform measurements based on the segmentation result. But before continuing, recall
how simple it was to detect the balls and handle all the intermediate iconic objects generated:

read_image (Die,’die3’)

threshold (Die, BrightRegion, 128, 255)

shape_trans (BrightRegion, ROI, ’rectangle2’)

reduce_domain (Die, ROI, DieROI)

threshold (DieROI, RawSegmentation, 0, 50)

f£ill_up_shape (RawSegmentation, Wires, ’area’, 1, 100)
opening_circle (Wires, BallRegion, 15.5)

connection (BallRegion, Balls)

select_shape (Balls, FinalBalls, ’circularity’, ’and’, 0.85, 1.0)

3.10 Working with Control Variables

So far we have detected the ball bondings within the image. Based on this segmentation we can
now perform some simple measurements. The most obvious measurement is to count the balls
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via count_obj (in Operators > Object > Information):

count_obj (FinalBalls, NumBalls)

Similiar to thedraw_rectanglel command irsection 3.5/0u generated a new control variable
calledNumBalls containing the desired number of balls. There are many different HALCON
operators computing specific features of regions (Bgerators > Regions > Features).
Among them, one you might try now &smallest_circle. This operator determines the posi-
tion and radius of the smallest circle containing each input region:

smallest_circle (FinalBalls, Row, Column, Radius)

Note thatFinalBalls contains six objects. Thus, six circles are calculated — one for each

of the input regions. Therefore, the output control variabBleg Column, andRadius do not

contain single values, but tuples of values. Again, no loop construct is necessary to process all
objects. Tuples of control values are shown in brackets within the variable window. If a tuple
variable contains too many elements to be shown at once, the value list is truncated and three
dots are added. For inspecting such a tuple, just double-click on the variable you want to see
with the left mouse button. A window will be opened containing all the elements of the tuple.
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Figure 3.10: The final result of the ball detection based on morphology.

The further processing of control data is facilitated by a built-in formula interpreter. See the
HDevelop User’s Manual for details. For example, you could compute the average value of the
tupleRadius with the following HDevelopassign statement (Se@perator > Control)

assign (meanRadius, sum(Radius) / |Radius|)

which is displayed in the program window as

meanRadius := sum(Radius) / |Radius]|

A more reasonable measurement concerning the quality control task might be the computation
of the minimum area of the balls. This can be achieved by applying the HALCON operator
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area_center (in Operators > Regions > Features), which calculates the area of each ball,
followed by anothenssign statement:

area_center (FinalBalls, Area, RowCenter, ColCenter)
minArea := min(Area)

Of course, tuples of control values can also be used as input parameters. For example, draw
the circles you have computed with the HALCON operatdgp_circle (in Operators >
Graphics > Output), seefigure 3.10

disp_circle (WindowID, Row, Column, Radius)

3.11 Finding Bonding Balls Using Pattern Matching

The morphologic approach detected the desired bonding balls by suppressing spurious parts of
the raw segmentation gained by thresholding. In this section you will encounter a completely
different approach to this detection problem. The pattern matching approach can be divided
into two steps:

1. Creating a so-calle@mplaté (typically during a training phase).

2. Searching for this template in the current image.

Figure 3.11: A template for a ball.

In our example we will create a template containing a single ball. To do this, just copy the two
program lines you used to generate a rectangular search sgatei 3.%:

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

3another word for the pattern that is searched in the image
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To do so, select the two program lines, copy them w&idht > Copy, position the insertion
cursor at the end of the program and sele¢it > Paste. Then, position theeC on the
draw_rectanglel command, presRun and draw a small rectangle containing nothing but
one of the balls, segure 3.11

Then copy the program line for reducing the image domain to the resulting region

reduce_domain (Die, ROI, ImageReduced)

Now you can transfornimageReduced, which is the original image restricted to the rectan-
gular domain you just have specified, to a template. This done by the HALCON operator
create_template (in Operators > Filter > Match):

create_template (ImageReduced, 5, 4, ’sort’, ’original’, TemplateID)

To obtain the center of the template (which will be needed for visualization purposes later) use
the followingassign statements:

TemplRow := (Rowl + Row2)/2
TemplCol := (Coll + Col2)/2

After the creation of the template you have the choice between different matching algorithms.
We will use a two-step strategy. First, a fast matching operator is applied to find all image points
where the template might match. In the second step, within each cluster of such points the exact
position of the template will be determined. The HALCON operatagt_match (again in
Operator > Filter > Match) delivers the regiomMatches containing all possible matching
positions:

fast_match (Die, Matches, TemplateID, 20)

Double-click on the original imageie and the result regionatch to see these positions. The
input parametefaxError is set to 20 in this example. There is a trade-off between performance
and fault tolerance of the matching. Decrease the value and watch the execution time when
applying the operator. For very small values of the tolerated error some of the balls might be
missed. On the other hand, increasing the value decreases the performance significantly.

Besidesfast_match there is also a HALCON operatdast_match_mg working on different
resolution levels, which in general increases the performance. Just try

fast_match_mg (Die, Matches, TemplateID, 20, 3)

to perform a search with three resolution levels and compare the execution time with the one
resolution method underlyinfpst_match.

After we have derived all posible matching positions, we decompose the corresponding region
into connected components:

connection (Matches, BallROI)
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If you specified a reasonable template and a suitédst&rror this should result in six regions
corresponding to the six (fully) visible balls in the image.

count_obj (BallROI, NumBalls)

Within each of the regions iBal1R0I we would like to determine the exact position of the
template. This can be done by another HALCON operator, caléat _match.* BallROI
contains only regions. Thus, we have to add an image, that is gray values, to the objects prior
to the final matching. This is done with the operai@d_channels (in Operators > Image >
Channel):

add_channels (BallROI, Die, BallImage)
best_match (BallImage, TemplateID, 20, ’true’, Row, Column, Error)

Note that thebest_match operator is applied to all objects containedBiil1Image. Thus,

the control output variableBow andColumn specifying the exact matching position aitror
containing the matching error should be tuples of values. To visualize the results we display
rectangles like the one used for the template generation — shifted by the offset beween the
matching positions and the center of the templatefigeee 3.12

disp_rectanglel (WindowID, Rowl+Row-TemplRow, Columni+Column-TemplCol,
Row2+Row-TemplRow, Column2+Column-TemplCol)

You should make sure that the region visualization is set to ‘'margin’ usiegalization >
draw before executing this command.

Figure 3.12: The final result of the ball detection based on pattern matching.

If you do not need the template any longer, it should be cleared with the HALCON operator
clear_template. Summarizing, the ball detection using pattern matching was done by the
following sequence of HALCON operators:

4Again, there is a multi-grid version of this matching operator, but since we already restricted the search to a
very small part of the image, it is not too interesting to bset match mg in this case.
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read_image (Die,’die3’)

draw_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)
gen_rectanglel (ROI, Rowl, Columnl, Row2, Column2)

reduce_domain (Die, ROI, ImageReduced)

create_template (ImageReduced, 5, 4, ’sort’, ’original’, TemplateID)
fast_match_mg (Die, Matches, TemplateID, 20, 3)

connection (Matches, BallROI)

add_channels (BallROI, Die, BallImage)

best_match (BallImage, TemplateID, 20, ’true’, Row, Column, Error)
clear_template (TemplateID)

Note that the check for correct shape and area of each ball is implicitly done by the pattern
matching. In the previous approach this was performed bypgheing circle operator.

By the way: Program lines that are not needed any more can be permanently removed. Just
select them (left mouse button) and chog&ét > Delete. Don't be shy — there is aRdit

Undo as well. To temporarily deactivate a line Uskit > Deactivate andEdit > Activate

to activate the line again.

3.12 Using Control Constructs

HDevelop offers various control statements to construct more complicated programs. For a
detailed specification see the HDevelop Users Manual. You already have encountered the
assign statement in the previous sections. We will now use two other control statements —
for andif — to further improve the example program.

Up to now, all matching positions returned byst_match in section 3.1were used to display

a rectangle. This might lead to undesirable results if the matching fails for some of the input
objects. Just decreadexError to 5, for example, to see what happens: For each input object
in BallImage which does not contain the template O is returneéldn andColumn® and the
maximum average gray value deviation of 255 is returneitiror.

The correct way to handle these matching errors is to check for all resulting matching positions
whether they are valid or not. Simultanously, the real number of detected balls can be computed:
Initialize a counter with thassign statement

RealNumBalls := O

Then program a loop with the counterand the end valuBumBalls (control statemenfor).
Inside the loop, check the error value of each match and skip faulty matches:

SA template position which is actually outside of the current image, bedawseand Column specify the
position of thecenterof the template.
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for i := 1 to NumBalls by 1
if (Error[i-1] < 255)
disp_rectanglel (Rowl+Row[i-1]-TemplRow, Columni+Column[i-1]-TemplCol,
Row2+Row [i-1]-TemplRow, Column2+Column[i-1]-TemplCol)
RealNumBalls := RealNumBalls + 1
endif
endfor

Display the original imag®@ie again and execute the above loop to see the result.
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Chapter 4

Philosophy of HALCON

This chapter explains the basic concepts of the HALCON system: its modular architecture and
its data structures. Furthermore, it describes HALCON'’s frame grabber interface.

4.1 Modular Structure

Applications

Language Independent Operator Interface

Frame
grabber

Interface

Visual

Basic C# Delphi etc.

Image Processing Library Extension
Package

Iconic Data Management Operator Knowledge Base

Figure 4.1: Layered structure of HALCON .

The base of HALCON is thdata managemembgether with theperator knowledge bas&he
data managementis reponsible for basic memory management (optimized for image processing)
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and on top of this for the creation, handling, and deletion of iconic objects and tuples. The
knowledge base stores information about operators, which can be accessed while the system is
running. All other modules make use of it to process image operations and to obtain information
about the configuration and current state of the system.

The knowledge base is also usedattomaticallygenerate the HALCON language interfaces

(for C, C++, and COM), all operator information used by HDevelop, the online help, and the
reference manuals. The operator knowledge base contains information about names and number
of operators, as well as parameter types, assertions and suggested values for the parameters.
This data set is stored in a structured way. There exists a detailed description for each operator
which handles the effects of the operator and which indicates the complexity, the operator class,
as well as cross references and alternatives.

On top of these two modules the operators are implemented. Most of them are contained
in the HALCON Image Processing Librarywhich is decribed in the Reference Manuals.
This library can be extended dynamically using so-cappadkages The operators of these
packages behave like normal HALCON operators, but they contain extensions to the stan-
dard library either generated by MVTec (for easy update) or by the user. This concept per-
mits the user to extend the system in a very flexible way. For more information see the
Extension Package Programmer’s Manual Using a similar mechanisnframe grabber in-
terfacesare integrated using dynamic libraries. This allows the user to integrate his/her own
frame grabber or to download new releases of frame grabber interfaces via the internet for fast
and easy update without further changes of the rest of the system.

The next module is théanguage-Independent Operator Interfack contains modules for
calling operators, handling the input/output and passing data objects to the host language. An
operator call is performed by tHeanguage Interfacewhich is generatedutomaticallyby a
compiler using the information in the operator database. There are three language inter-
faces: HALCONY/C allows to access HALCON operators within the programming language C,
HALCON/C*++ within C++, and HALCON/COM (Windows NT/2000/XP only) within pro-
gramming languages or environments that support COM, e.g., Microsoft Visual Basic, C#, or
Borland Delphi. Note that you can also use HALCON/COM within Visual C++ programs, but
then you cannot use HALCON/#G in the same program, because only one HALCON lan-
guage interface can be used in a single application, be it directly or indirectly, e.g., by including
a DLL that uses a second interface.

HDevelop is implemented on top of the language interface using the language interface HAL-
CON/C and the GUI toolkitvxWindows developed by thdtrtificial Intelligence Applications
Instituteat The University of Edinburgto get a portable user interface for Windows and UNIX.

4.2 Handling Iconic and Control Data

HALCON distinguishes two types of dataonic and control data. Iconic data is related to

the original image (images, regions, XLD objects; see beld@dntrol data are all kinds of
“numerical” values, such as integers, floating-point numbers, or strings; this kind of data defines
input values for operator control parameters and is used to build complex structures like bar
charts or arrays of control values. Both ieenic andcontrol data — are processed according

to the “tuple scheme” within HALCON.
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4.2.1 Tuple Processing

Whenever an input or output parameter of a HALCON operator contains data, it may be a single
object/value or a tuple of objects/values. If a tuple is passed HALCON processes the operator
simultaneously on all tuple members. For example, if you want to process a median filter on
six different images, you might call the operat@dian_image Six times with varying input
images. Or you might generate a tuple containing all six images angleghlbn_image once

with the tuple as input object. HALCON filters all tuple elements simultaneously and returns a
tuple containing six filtered images. We have seen another example befdrapter 3where
several regions have been extracted from an input image. The regions became elements of one
region tuple. If you want to know the center of all regions, you simply have to pass this tuple to
the operatoarea_center. HALCON then returns a tuple of integer pairs containing the pixel
positions of all centers.

Now that we know how tuples are processed we can have a closer look at the different object
classes of iconic data: images, regions, and XLD objects.

4.2.2 Image Objects

Image objects contain the pixel data for image processing. They may be tuple objects containing
more than one image object or a single image object. Every single image object consists of one
domaindescribing its area of definition and one or mahannelscontaining the gray values

of the pixels (cf.figure 4.3. The number of channels is not restricted. A monochrome image
may only have one channel, a color image may contain three channels according to the RGB
scheme, a multisensor image may have several channels.

The domain of an image object may be of any size and is representectpn Thus, it can

have holes or may consist of several, unconnected areagge®4.3. The default domain of

an image object is the smallest rectangle enclosing the image. It may be changed to any size,
e.g., via the operatateduce_domain, S0 that every image has its individual domain.

Introducing an area of definition for an image has the following advantage: All image operators
work only within this image domain. This allows to focus the processingregian of interest

The amount of data to work on becomes smaller so that the processing is sped up. An example
that explicitly makes use of this can be found as HDevelop program namtetbahn.dev

under the pathHALCONROOTY \examples\hdevelop\Applications\Sequences.

4.2.3 Region Objects

Regions define areas in images, e.g., the domain of an image or the light areas of an image.
Region objects consist of one or more regions. They are handled as separate objects independent
from any image object, although they may represent an area within a specificimage. This allows
to use flexible shapes and sizes for regions and to store them efficiently. Only the region area
must be represented in memory — independent from the gray values of the pixels. Moreover,
this allows to define overlapping regions for the same image without the implicit merging that
would happen when storing regions as matrices.

Region data is represented by a special variant of the runlength encoding -ehbydeencod-
ing: for every line (chord) of a region its row index (y-coordinate of chord; “line number”) and
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Figure 4.2: Structure of HALCON image objects.

regions may contain holes regions may be compact

I region 2 I region 4
N
regions may consist of regions may exceed
several, unconnected areas the image size

Figure 4.3: Different forms and sizes of regions.

the x-coordinates of its start- and end-point is stored. Both — the start-point and the end-point
— belong to the region. This allows a very compact representation of regions in memory and
an efficient region processing, especially with morpholgic operations.
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Regions may be of any size and therefore even may exceed the image size. This is an ad-
ditional advantage, since it prevents artifacts. For example, imagine you want to close a
region with a circular structuring element to smooth the region’s boundaries and to close
holes within the region, e.g., via the operatdrosing circle. You use this to extract

a little fin (seefigure 4.40r cf. the HDevelop program exampfein2.dev under the path
%HALCONROOT?\examples\hdevelop\Applications\FA). The closing is done by a dilation
followed by an erosion, both with the same circular structuring element — in our case a circle of
radius 250 (you may think that 250 is rather large, but with the advanced performance of HAL-
CON this causes no performance problem). Now imagine that the maximum region size would
be restricted to the image size. Thus after processing the first step (the dilation) the resulting
region has to be clipped to the image size (sgare 4.4a). The following erosion would work

on a restricted area and therefore result in a much smaller area than the correct processing (see
figure 4.4b). This would make the correct extraction of the fin impossible.

region after dilation
within background region

original image background r\egion

region after clipping region after erosion within
to image size clipped region

region after e@sion without clipping

®) difference between this region
and the background region

exctracts the fin!

resulting region is too
small; correct extraction
of the fin is not possible!

Figure 4.4: Example of region processing.

4.2.4 XLD Objects

XLD is the abbreviation forXtendedL ine Description. This is a data structure used for de-
scribing areas (e.qg., arbitrarily sized regions or polygons) or any closed or open contour, i.e.,
also lines. In contrast to regions, which represent all areas at pixel precision, XLD objects
provide subpixel precision. There are two basic XLD structures: contours and polygons.
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An XLD object is built up by setting base points along the contour/lines and connecting them
with lines. They can represent a contour (or set of lines) at any precision by varying the number
and position of the base points at subpixel precision. Additional information, such as gradient,
filter response, or angle is stored with the points and lines. Typically, XLD objects describe the
result of operators for edge/line detection (eedges_sub_pix, lines_gauss). In particular,

they are used for image processing at subpixel precision and offer a wide range of features and
transformations. See thextension Package Programmer’s Manuafor internal details.

4.3 The HALCON Frame Grabber Interface

Currently, HALCON provides interfaces for more than 50 frame graBbir$orm of dynami-
cally loadable librariegWindows: DLLs; UNIX: shared libraries). These libraries are installed
together with the HALCON libraries (sesection 2.1.4or the file structure). Library names
start with the prefiXiFG; the libraries starting witlparHFG are used by Parallel HALCON (see
alsosection 5.3.2

The HALCON frame grabber interface libraries form the bridge between software provided by
the frame grabber’'s manufacturer and HALCON. They form a common, generic interface by
providing the following operators:

open_framegrabber opens and configures a specified frame grabber. Depending on the frame
grabber, several parameters must be specified, e.g. describing the type of the used camera
or the port the camera is connected to.

info_framegrabber returns information about a specified frame grabber, e.g., the default
parameters used ypen_framegrabber.

set_framegrabber_param andget_framegrabber_param allow to set or read additional pa-
rameters. Which parameters are supported by a HALCON frame grabber interface can be
queried via the operatdmfo_framegrabber. For more information about the param-
eters please refer to the corresponding online documentation which can be found in the
directory’,HALCONROOT?\doc\html\manuals. The html start page is also available from
the HALCON folder in the Windows start menu. If you did not install the documentation,
please take a look at the web site mentioned above.

grab_image andgrab_image_async grab an image from a specified frame grabber. For the
difference between the two modes of grabbing see below.

grab_image start starts an asynchronous grabbing from the specified frame grabber (see
below for more details).

close_framegrabber andclose_all framegrabbers close the connection to one or all
frame grabbers and release the corresponding resources, e.g., free the previously allo-
cated memory.

set_framegrabber_lut andget_framegrabber_lut allow to set or read a frame-grabber-
specific lookup table. These operators are only supported by some frame grabbers.

!Please refer tattp: //www.mvtec. com/halcon/framegrabber for an up-to-date list.
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If you successfully installed your frame grabber, all you need to do to access it from HALCON
is to call the operataspen_framegrabber, specifying the name of the frame grabber and some
additional information, e.g., regarding the connected camera (see the corresponding entry in
the Reference Manual for detailed information). Then, images can be grabbed by calling the
operatorgrab_image (Or grab_image _async, see below).

Please note, that the HALCON frame grabber interfaces may change more often than the HAL-
CON library itself. One reason is that MVTec continuously develops new interfaces; further-
more, if the software provided by the frame grabber manufacturers changes, e.g., if new fea-
tures are integrated, the corresponding HALCON interfaces will be adapted. You can find
the latest information together with downloadable interfaces (including documentation) under
http://www.mvtec.com/halcon/framegrabber.

4.3.1 The Two Modes of Grabbing Images

HALCON distinguishes two grabbing modes: synchronous and asynchronous graSgmg.
chronous grabbingneans that the application tells the frame grabber to grab a new image by
calling the operatograb_image, and waits until the image is ready. In other words, the applica-

tion synchronizes itself with the grabbing process. The advantage of this mode is that grabbed
images are always up to date. However, because the grabbing process can take quite a time
to complete, e.g.40ms with standard PAL, real-time image processing becomes difficult (if

not impossible) using synchronous grabbing. Synchronous grabbing is even more problematic
when using an external trigger (see the following section), as then the application will wait for
the trigger.

The second mod@&synchronous grabbingupportgeal-time image processingn this mode,

the grabbing process is divided into two steps: First, the application tells the frame grabber
to start grabbing a new image by calling the opergtotb_image start. This operator im-
mediately returns; thus, the application can continue with its own task, e.g., process the previ-
ous image while the frame grabber grabs a new image. To actually fetch the new image, the
application calls the operat@rab_image_async. If the frame grabber has already finished
grabbing the imagerab_image_async returns directly with the image; otherwise the operator
waits until the frame grabber has finished. Furthermpgrgb_image_async allows to specify

“how old” the grabbed image is allowed to be. If the image is too githb_image async
automatically starts a new grab and waits for its completion. Before returning, the operator
grab_image_async automatically starts a new grab; therefore, you do not need to call the op-
eratorgrab_image_start anymore after the first grab.

Note, that asynchronous grabbing is the more powerful of the two modes, but requires a careful
timing on the part of the user. In other words, image processing (application side) and grabbing
process (frame grabber) can only run asynchronously if the opegater image async is

called when the image is already grabbed (and not too old already)!

4.3.2 Using External Triggers

Independent of the grabbing mode, you can usexarnal trigger signako start the actual
grabbing process in the camera (if the frame grabber supports this option) and thereby synchro-
nize the image grabbing to a physical process, e.g., by using photoelectric barriers that report
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when a part has arrived for inspection. All you need to do to use this feature from HALCON is
to specify a corresponding parameter in the calijen_framegrabber.

Please note the difference between the two ways of synchronizing described here and in the
previous section: In the synchronous grabbing mode, your application software is synchronized
with the process of image grabbing so that image processing starts directly after getting a new
image. When using an external trigger, image grabbing is synchronized with an external process
so that the grabbed image corresponds to a certain situation, e.g. with an object directly under
the camera.

When using an external trigger signal, keep in mind that after being told to grab an image the
frame grabber waits for this signal — possibly ad infinitum if this signal is not triggered! Together
with the frame grabber, calls to the operagafab_image (and evengrab_image_async, If

called before the signal comes) have to wait.

Most HALCON frame grabber interfaces allow to specify a timeout for grab-
bing via the operatorset_framegrabber param (please consult the corresponding
online documentation in the directory,HALCONROOT%\doc\html\manuals oOr under
http://www.mvtec.com/halcon/framegrabber). If a grab runs into a timeout, the corre-
sponding operator returns the valil&€RR_FGTIMEQUT.

Please note, that in order to really synchronize the grabbing process with an external event,
the camera must be able to start a new image immediately. This feature is typically called
asynchronously resettablé a camera does not have this feature, the frame grabber must wait
for the camera to finish its current frame before starting to grab. This means that there will be a
delay between the external trigger and the start of the grabbing. Even worse from the point of
view of real-time applications, the exact duration of this delay is unknown, as it may lie between
zero and the time needed for one frame.

Summarizing, in applications with hard real-time constraints external triggers should be used in
conjunction with an asynchronously resetable camera and the asynchronous grabbing mode.

4.3.3 Volatile Image Grabbing

By default, the operatorgrab_image andgrab_image_async copy the image data written by

the frame grabber into a certain memory area into a HALCON image object. The advantage
of this mode is that your application can process the returned image object as long as it likes
without it being “overwritten” by a subsequent grab. Furthermore, the application can keep a
history of images if necessary.

As copying costs processing time (typically ab@ut 3ms for a NTSC image) which might

be precious in a real-time application, some HALCON frame grabber interfaces offer the so-
calledvolatile grabbing modeln this mode, the frame grabber directly writes the image data
into a HALCON image object used by the application. Thus, no copying is required. The
drawback of this mode is that older images will be overwritten by subsequenf gtiais the
name “volatile”.

Whether a frame grabber interface supports volatile grabbing is noted in its online documenta-
tion.

2In fact, the HALCON frame grabber interfaces internally use a so-caltetble bufferingstrategy to assure
that a HALCON application can process one image while the next image is grabbed. Then, buffers are switched
so that with the third grab the first image is overwritten.
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4.3.4 Using Frame Grabbers Without a HALCON Interface

If you use a frame grabber that is not yet supported by HALCON, you can integrate a cor-
responding interface into HALCON. How to create and integrate a frame grabber interface
is described in th&rame Grabber Integration Programmer’s Manual , which also contains
sample source code.

If you already have a program that communicates with the API of your frame grabber and
want to use HALCON to process the images, you can convert the images grabbed by your
program to HALCON images by passing HALCON a pointer to the image buffer using the
operatogen_imagel_extern (See the corresponding entry in the Reference Manual for detailed
information).

4.4 Limitations

There are some HALCON limitations which you have to keep in mind, although you won't
come even near these limits in most applications:

e Maximum image size: 32768 32768

e Maximum number of image matrices in mem#rg00000
e Maximum number of objects per parameter: 100000

e Maximum number of channels per image: 1000

e Maximum number of values in a tuple: 1000000

e Maximum number of contour points: 30000

e Maximum number of polygon control points: 10000

e Range for coordinates: from32768 to +32767

e Maximum length of strings: 1024 characters

3Not to be confused with image objects, since objects can share the underlying gray values.
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Chapter 5

Using Parallel HALCON

This chapter explains how to use Parallel HALCON, concentrating on the main features of
Parallel HALCON: automatic parallelization and the support of parallel programming.

Like standard HALCON, Parallel HALCON can be used in two ways: You can integrate the
corresponding libraries in your ownt@, C, or COM programs, or you can use the parallelized
variant of HDevelop, Parallel HDevelop.

Parallel HALCON and HDevelop

Like the HALCON library, HDevelop exists in two variants: The standard HDevelop builds
upon the standard HALCON library; as before the corresponding executable isteiiied op
(orhdevelop.exe). The second variant builds upon Parallel HALCON and therefore automat-
ically parallelizes operators if used on a multi-processor hardware. The corresponding exe-
cutable is callegparhdevelop (Or parhdevelop.exe); under Windows NT/2000/XP, you can

start it via the mengtart > Programs > MVTec HALCON > Parallel HDevelop.

Note, that Parallel HDevelop differs from standard HDevelop only insofar that it uses the auto-
matic parallelization mechanism. You cannot write parallel programs inside Parallel HDevelop.

Parallel HALCON in a Stand-Alone Application

To create an application using Parallel HALCON, you must link the corresponding
libraries to your programs. Under Windows NT/2000/XP, you need the libraries
parhalconc.dll, parhalconcpp.dll, Or parhalconx.dll, depending on the used pro-
gramming language. Under UNIX, you need the libraribhalcon.so and, depend-
ing on the used programming languagkibparhalconc.so Or libparhalconcpp.so.
Please consult thelALCON/C User’s Manual, the HALCON/C ++ User’s Manual, or the
HALCON/COM User’'s Manual , respectively, for more detailed information.

5.1 Automatic Parallelization

If Parallel HALCON is used on multi-processor hardware, it will automatically parallelize im-
age processing operatofection 5.1.Hescribes how to initialize Parallel HALCON in order to
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use this mechanisngection 5.1.2xplains the different methods which are used by HALCON
operators for their automatic parallelization.

5.1.1 Initializing Parallel HALCON

In order to adapt the parallelization mechanism optimally to the actual hardware, Parallel HAL-
CON needs to examine this hardware once. Afterwards, HALCON programs will be automat-
ically parallelized without needing any further action on your part. Even existing HALCON
programs will run and be parallelized without needing to be changed.

You trigger this initial examination by calling the operat@reck par_hw_potential (see the
corresponding entry in the HALCON Reference Manuals for further information). Note, that
this operator will only work correctly if called from Parallel HALCON; if you call the standard
HALCON version (e.g., from HDevelop instead of Parallel HDevelop), a corresponding error
message is returned. Similarly, if you call the operator on a single-processor computer, it will
return an error message. As a shortcut, you may call the executabdek parallel which
resides in the directorydALCONROOT?,\bin\%ARCHITECTUREY,.

Upon callingcheck_par_ hw_potential, Parallel HALCON examines every operator that can

be sped up in principle by an automatic parallelization. Each examined operator is processed
several times - both sequentially and in parallel - with a changing set of input parameter values,
e.g., images. The latter helps to evaluate dependencies between an operator’s input parameter
characteristics (e.g. the size of an input image) and the efficiency of its parallel processing. This
examination may take up to 10 minutes, depending on your computer.

The extracted information is stored in the registry (under Windows NT/2000/XP) or in the file
.halcon_par_info in the directory$HALCONROOT (under UNIX). Please note, that on some op-
erating systems you need special privileges to initialize Parallel HALCON successfully, other-
wise the operatotheck_par_hw_potential is not able to store the extracted information. Un-

der Windows 2000, you need administrator privileges or the group privileg@sr User’.

Under UNIX, per default only the user who installed HALCON can create (or modify) the file
.halcon par_info. Please note, that the operatheck par hw potential returns without

an error if it cannot store the extracted information. In contrast, the progeastk_parallel

checks privileges and writing permissions beforehand and returns with a corresponding error
message.

5.1.2 The Three Methods of Automatic Parallelization

For the automatic parallelization of operators, Parallel HALCON expiizita parallelismi.e.,
the property that parts of the input data of an operator can be processed independently of each
other. Data parallelism can be found at three levels:

1. tuple level
If an operator is called with iconic input parameters containing tuples, i.e., arrays of
images, regions, or XLDs, it can be parallelized by distributing the tuple elements, i.e.,
the individual images, regions, or XLDs, on parallel threads. This method requires that
all input parameterscontain thesame number of tuple elemerfts contain a single
iconic object or value).
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2. channel level
If an operator is called with input images containing multiple channels, it can be par-
allelized by distributing the channels on parallel threads. This method requireslthat
input image objectsontain thesame number of channeds a single channel image.

3. domain level
Every operator can be parallelized by dividing its domain and distributing its parts on
parallel threads.

The description of a HALCON operator in the Reference Manuals contains an entry called
'Parallelization Information’, which specifies its behavior when using Parallel HALCON. This
entry indicates whether the operator will be automatically parallelized by Parallel HALCON
and by which method (tuple, channel, or domain).

5.2 Parallel Programming Using Parallel HALCON

Parallel HALCON supports parallel programming by being thread-safe and reentrant, i.e., dif-
ferent threads can call HALCON operators simultaneously without having to wait. However,
not all operators are fully reentrant. This section takes a closer look at the reentrancy of Parallel
HALCON. Furthermore, it points out issues that should be kept in mind when writing parallel
programs that use Parallel HALCON.

The example prograrxample multithreadedl.c in the directoryexample\c shows how to
use multithreading to extract different types of components on a board in parallel using Parallel
HALCON/C.

5.2.1 A Closer Look at Reentrancy

In fact there are different “levels” of reentrancy for HALCON operators:

1. reentrant
An operator is fully reentrant if it can be called by multiple threads simultaneously
independent of the data it is called with.

2. local
This level of reentrancy is only relevant under Windows NT/2000/XP.

Under Windows NT/2000/XP, operators markedasl should be called only from the

main thread(and not from arexternal threadl Typical examples are operators that use
graphical I/O functions. The reason is that under Windows NT/2000/XP, there exists

a direct mapping between program threads and graphical elements, such as windows,
dialog boxes or button controls. In short, a graphical element only exists in the context
of its associated thread. This can cause severe problems (for example, hang the applica-
tion) if a thread tries to perform user interactions via graphical elements that belong to
another thread. For example, you may get a deadlock if one thread opens a window via
open_window and another thread tries to get input from this windowd#taw_circle.

As itis not always obvious whether an operator works with critical (graphical) elements
or not, such operators are marked@sal. Note, that you can still use them outside the
main thread, however, you might get problems.
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3. single write multiple read
A certain group of operators should be called simultaneously only if the different calling
threads work on different data. For example, threads should not try to modify the same
template for pattern matching simultaneously by callidgpt_template with the same
handle. Exactly the same applies to the case that one thread should not modify a data set
that is simultaneously read by another thread. Other groups of operators with this be-
havior are concerned with file I/O (e.gzite_image —read image, furite _string —
fread_string but also non-HALCON file commands) or background estimation (e.g.,
update_bg_esti —give_bg esti).

As this thread behavior is not recommended quite generally, Parallel HALCON does not
actively prevent it and thus saves overhead. This means that if you (accidentally) call
such operators simultaneously with the same data no thread will block, but you might
get unwelcome effects.

4. mutual exclusive
Some operators cannot be called simultaneously by multiple threads but may be exe-
cuted in parallel tmtherHALCON operators. Examples for mutual exclusive operators
arecombine_roads_x1d, pouring, Of concat_ocr_trainf.

5. completely exclusive
A group of operators is executed exclusively by Parallel HALCON, i.e., while such an
operator is executed, all other threads cannot call another HALCON operator. Examples
are all OCR/OCV operators that modify OCR classificators, all operators that create
or delete files, display operators lik@en_window or disp_image, and the operator
reset_obj_db. For the latter, a programmer has to assure that all operators that are to
be executedbeforereset_obj_db is called have already finished, because this operator
resets HALCON and therefore strongly influences its behavior.

As mentioned already, the description of a HALCON operator in the Reference Manuals con-
tains an entry called 'Parallelization Information’, which specifies its behavior when using Par-
allel HALCON. This entry specifies the level of reentrancy as described above.

5.2.2 Style Guide

¢ Initialization
Before calling HALCON operators in parallel in a multithreaded program, you have to
call one operator exclusively. This is necessary to allow HALCON to initialize internal
structures.

In principle, you can choose any HALCON operator for this initial call; we recommend
reset_obj_db as this operator initializes the global image size.

e |/O
Under Windows NT/2000/XP, use I/O operators (including graphics operators like
open_window Or disp_image) only in the main threadotherwise you might get a dead-
lock. This means that you should not open a window in one thread and request a user
interaction in it from another thread. In the Reference Manual, these operators are marked
aslocally reentrant(seesection 5.2.1

Keep in mind that operators which create or delete files work exclusively, i.e., other threads
have to wait.
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The programmer has to assure that threads do not access the same file (or handle) simul-
tanously!

e Multithreading vs. Automatic Parallelization
If you explicitely balance the load on multiple processors in a multithreaded program,
we recommend to switch off the automatic parallelization mechanism in order to get
an optimal performance. How to switch of the automatic parallelization is described in
section 5.3.1

5.3 Additional Information

This section contains additional information that helps you to use Parallel HALCON.

5.3.1 How to Switch Off Reentrancy or Automatic Parallelization

You can switch off parts of the features of Parallel HALCON with the help of the operator
set_system. To switch off the automatic parallelization mechanism, call (HDevelop notation,
see the Reference Manual for more information)

set_system(’parallelize_operators’,’false’)

To switch of reentrancy, call

set_system(’reentrant’,’false’)

Of course, you can switch on both behaviors again by caBig system with the >true’
as the second parameter. Please note, that by switching off reentrancy you also switch off
automatic parallelization, as it requires reentrancy.

Switch off these features only if you are sure you don’t need them but want to save the corre-
sponding computing overhead. If you write sequential programs to be run on a single-processor
computer, the best way to save overhead is to use standard HALCON, of course.

A reason for switching off the automatic parallelization mechanism could be for debugging or
if your multithreaded program does its own scheduling and does not want Parallel HALCON to
interfere via automatic parallelization. Note, that you do not need to switch off automatic par-
allelization when using Parallel HALCON on a single-processor computer; Parallel HALCON
does not create any corresponding overhead if it detects only one processor.

5.3.2 Using a Frame Grabber in Parallel HALCON

All frame grabbers supported by HALCON can be used in Parallel HALCON as well.
Please note, that none of the frame grabber operators is automatically parallelized. Most
of the operators are reentrant, only the operators concerned with the connection to
the frame grabberopen framegrabber, info_framegrabber, close framegrabber, and
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close_all framegrabbers) are processed completely exclusively. Furthermore, these oper-
ators ardocal, i.e., under Windows NT/2000/XP they should be called from the main thread
(seesection 5.2.1

Under Windows NT/2000/XP, each frame grabber interface comas@BLLs", one for stan-
dard HALCON (prefixHFG) and one for Parallel HALCON (prefigarHFG). Both HALCON
versions automatically load “their” interface libraries, so you do not need to worry about it.

Under UNIX, both standard HALCON and Parallel HALCON work with the same shared li-
brary (prefixHFG).

5.3.3 Extension Packages and Parallel HALCON

To be used in Parallel HALCON, extension packages must be provided in a second version
including the prefixpar in the name of the libraries. For example, if the package is called
halconuser, Parallel HALCON looks for the libraripsrhalconuser.d1l under Windows
NT/2000/XP orlibparhalconuser.so under UNIX, respectively.

More information about extension packages in Parallel HALCON can be found in the
Extension Package Programmer’s Manual

5.3.4 Parallel HALCON and HALCON Spy

As HALCON Spy (seesection 6.4 is working sequentially, it cannot be used to monitor a
Parallel HALCON program.

1seesection 2.1.4or the file structure of HALCON
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Chapter 6

Tips and Tricks

This chapter contains information that helps you working with HALCON, including sections
on troubleshooting.

6.1 News About HALCON

If you select HDevelop’s menu enttglp > HALCON News (WWW), you can check for the latest
news about HALCON on MVTec’'s WWW server, e.g., whether new extension packages, frame
grabber interfaces, or HALCON versions are available.

6.2 A Note on Windows 2000 and Windows XP

By default, Windows 2000 and Windows XP use visual effects, e.g., when opening menus,
that as a side-effect slow down programs with graphics output. In the context of HALCON,
especially HDevelop is affected significantly. We therefore recommend to disable these effects
in the dialogStart > Settings > Control Panel > Display.

6.3 Online Help in HDevelop

HDevelop offers you a broad range of support.

e System suggestions
Based on theoperator knowledge basthe system offers specific advice to choose an
appropriate operator. Thus, there are suggestions for reasqrablecessorand suc-
cessors If you are searching for different ways of solving an image analysis problem
you may have a look alternativesor referencef an operator. If you only have some
keywords or thematic aspects in mind which an operator has to fulfill, but you cannot re-
member the operator’'s name, you have the possibility to obtain an operator by specifying
one or more&keywords
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e Online help on operators
HALCON offers a detaile@nline helpfor each HDevelop operator. These manual pages
are highly structured, thus allowing you to easily get an understanding of an operator.
Moreover,cross referencesnmediately give you a survey of the operator’s relations. To
use this help you only need an appropriate HTML browser.

e Debugging help
You may choose between differanbdes of running program. You have the possibilities
to perform single steps of a program, to set breakpoints, or to run a program continuously.

To get meaningfudebugging supporyou may also specify the environment variable
HALCONSPY (seesection 2.4.2

e Result visualization
HDevelop offers the immediat@spectionof an operator’s results. This visualization
mechanism helps you to spot problems quickly. Additionally, it is very easy for you to
modify graphics output parameters to optimize your graphics results.

6.4 Monitoring HALCON Programs with HALCON Spy

HALCON Spy helps you to debug image processing programs realized with HALCON oper-
ators by monitoring calls to HALCON operators and displaying their input and output data in
graphical or textual form. Furthermore, it allows you to step through HALCON programs.

HALCON Spy is activated within a HALCON program by inserting the line (in HDevelop
notation)

set_spy(’mode’,’on’)

Alternatively, you can activate HALCON Spy for an already linked program by defining the
environment variabl&HALCONSPYY, (i.e., by setting it to any value). How to set environment
variables is described section 2.4

You specify the monitoring mode by calling the operatet_spy again with a pair of parame-
ters, for example

set_spy(’operator’,’on’)
set_spy (’input_control’,’on’)

to be informed about all operator calls and the names and values of input control parameters.
The monitoring mode can also be specified via the environment vaf{able€0ONSPY%. Under
Windows NT/2000/XP, sétHALCONSPY?, to the value

operator=on;input_control=on

to get the same mode as in the example above. Under UNIX, esleminstead of a semicolon
to separate options.

Please take a look at the entry fest_spy in the HALCON Reference Manuals for detailed
information on all the debugging options. Note, that HALCON Spy does not work properly
under Parallel HALCON.
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6.5 Troubleshooting

This section offers help for problems encountered during installing or uninstalling HALCON,
when using HDevelop, or when using Parallel HALCON.

6.5.1 Problems During Installation

e Registration of halconx.d11 failed
On some systems you might get a warning message that the HALCON/COM interface
library halconx.dl11 failed to self-register. A possible cause for this may be that the Mi-
crosoft libraryat1.d11 was not registered properly. This library resides in the directory
%SystemRoot\system32, e.g.,C:\WINNT\system32. To register the library, open a
Windows Command Prompt, change into the direciniryc\i586-nt4 on the CD, and
execute the supplied programag_halconx twice as follows:

reg_halconx atl.dll
reg_halconx

The first call ofreg_halconx registersatl.dl1, the second one registérslconx.d11.

As an alternative to the Command Prompt, you can use the d&alagt > Run; here,
you must either type the full path of the prograg_halconx or select the program via
the buttorBrowse.

¢ Installing and uninstalling the license manager daemon
Occasionally, the FLEXIm license manager daemon needed for floating licenses is not
installed properly by the HALCON setup. How to install the license manager daemon
manually is described isection 2.3.4.1

6.5.2 Problems During Uninstallation

e Unregistration of halconx.d11
If you had to register the HALCON/COM interface librahalconx.d11 manually as
described irsection 6.5.1lyou must unregister it manually before you can uninstall HAL-
CON. To do so, insert a HALCON CD, then open a Windows Command Prompt,
change into the directonyisc\i586-nt4 on the CD, and execute the supplied program
reg_halconx as follows:

reg_halconx /u

As an alternative to the Command Prompt, open the digtegt > Run, select the pro-
gramreg_halconx Vvia the buttorBrowse, append the optiostu, and then cliclOk.

¢ Uninstallation of the license manager daemon
As mentioned irsection 2.2.1lif you uninstalla HALCON 5.0 or 5.1 version with floating
licenses the FLEXIm license manager daemon occasionally is not uninstalled properly.
How to uninstall the license manager daemon manually is descritsstiion 2.3.4.1
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e ‘“Internal Error”
If the uninstall process is terminates with a message like

“Internal Error, unable to load or call external DLL. Please contact your
distributor for more information.”

the most likely reason is that a new HALCON version was installed over an existing one
without completely removing the old files first.

Other possible reasons might be that the whole HALCON directory was moved to an-
other position on the hard disk, or the environment varigHk.CONROOTY, was changed
manually. You have to follow the following steps to recover from the error:

1. Check if the environment variabléHALCONROOT% matches the location of
your HALCON directory. You can check this via the system control
panelSystem (look for Environment) or in a Windows Command Prompt via
echo %HALCONROOT%. If the variable contains nothing or the files are in some
other location, you have to set HALCONROOT manually via $getem control
panel.

2. Check if these two files are present:
e In your’HALCONROOTY directory:Uninst.isu

e In the directory),HALCONROOT’,\FLEX1m\1586-nt4: HalconUninst.d11!

Note that by default the Windows Explorer doesn’t show DLL files, unless you
explicitly tell it to do so. Uninst.isu has been created during the installa-
tion. If this file has been removed, an automatic uninstallation is not possible.
HalconUninst.d1ll is a HALCON specific DLL for the uninstallation process.

If this file has been removed you can get a copy of the file from the directory
FLEX1m\i586-nt4 on the HALCON CD.

3. Check, if the registry entry for the uninstaller is set properly: Stggedit.exe
in a Windows Command Prompt or in the dial®gart > Run, and go to

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall -> HALCON <Version-Number>,

where<Version-Number> is the version number of the HALCON version you
want to uninstall or is not present. There, you should find a key named
UninstallString. The value of this string should be somettitige this:

C:\WINNT\IsUninst.exe —£"C:\Program Files\MVTec\HALCON\Uninst.isu"
-c"C:\Program Files\MVTec\HALCON\FLEX1m\i586-nt4\HalconUninst.d11"

Make sure that the path \Program Files\MVTec\HALCON (or equivalent)in the
above example points to tH@IALCONROOT?, directory. Note that filenames that
contain blanks have to be quoted with'path". This is true in the above example
since “Program Files” does contain a blank. Older versions of the HALCON setup
program failed to do so. If you encounter unquoted path names containing blanks,
please insert the quotation marks yourself.

1For HALCON 5.0 and 5.1, this DLL was callé$Uninst .d11.
2The option-c. . . is only included if you have chosen an installation with floating licenses.
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4. Close the registry editor and try to run the uninstaller again.

e Uninstallation failed
If the automatic uninstallation fails for another reason, proceed as follows:
1. For floating licenses only: Uninstall the license manager daemon as described in
section 2.3.4.1
2. Startregedit and delete the keys

HKEY_LOCAL_MACHINE -> SOFTWARE -> Microsoft -> Windows ->
CurrentVersion -> Uninstall -> HALCON

and
HKEY_LOCAL_MACHINE -> SOFTWARE -> MVTec -> HALCON

3. Using, e.g., the Windows Explorer, delete the directory

%SystemRoot’\Profiles\All Users\Start Menu\Programs\MVTec HALCON

Note that/SystemRoot’, usually iSC: \WINNT.
4. Finally, delete the HALCON base directd¢jALCONROOTY.

6.5.3 Problems Concerning Licenses

If you encounter problems with your HALCON license even though your license file exists and
is located in the correct directory, a first step is always to check if the information identifying
your computer (or dongle) (sexection 2.3.1 matches the corresponding entries in the license
file (seesection 2.3.3 If the two do not match, please send the new identifying information to
your distributor. See below if you encounter problems with extracting the identifying informa-
tion.

If you are using floating licenses, please have a loaeation 2.3.4especially regarding the
choice of a suitable port number for the license manager daemon.

If you are using a dongle-bound license with HALCON 6.0.2 or higher and get the message
“license not found” or a similar error message, you might need to uninstall the old dongle
driver and install the new one manually as describeskittion 2.3.5.1

6.5.3.1 Problems When Extracting Identifying Information

e “About HDevelop” does not show any host IDs

If HDevelop fails to detect any host IDs although your computer does have a network
board, a Pentium Ill, or a dongle, please try to extract the host IDs manually as described
in section 2.3.1.2

e Licensing via network card does not work when network is not connected
On Windows 2000 and Windows XP systems, you must disable Media Sense (DHCP)
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when no network is connected to the network card. Usually, it is sufficient to
disable the DHCP protocol in this case. Further details can be found under
http://support.microsoft.com/support/kb/articles/Q239/9/24.asp.

e 1Imhostid -ether returns "ffffffff" or "0"

If Imhostid returns"ffffffff" or "0", this usually indicates that you do not have a
network board. If you do have one, on Windows 2000 and Windows XP systems check
whether the client for Microsoft networks is installed in the diafagirt > Settings

> Network and Dial-up Connections > Local Area Connections > Properties.

If the client for Microsoft networks does not appear in the list install it by clicking
Install and then selecting it from the list of clients. Then, repeat the steps described
in sections 2.3.1.br2.3.1.2

On Windows NT systems check whether the NetBEUI and TCP/IP protocols are installed
in the dialogStart > Settings > Control Panel > Network > Protocol. If the proto-

cols do not appear in the dialog, please install these two protocols by adding them in the
dialog. Then, repeat the steps describesdations 2.3.1.br 2.3.1.2

e Multiple I1Ds for only one network card

On Windows 2000 and Windows XP systems, sometimes more than one ID is returned
even if there is only a single network card. In this case, use the ID that remains when both
the NetBEUI and IPX/SPX protocols are disabled. Alternatively, use the ID that does not
change when you reboot the machine.

e Ilmhostid -cpu64 returns ""
If Imhostid returns an output like
> 1lmhostid -cpu64
lmhostid - Copyright (C) 1989-2000 Globetrotter Software, Inc.

The FLEXIm host ID of this machine is ""
Imhostid: FLEX1m function not available in this version <-45,520>

this indicates that the processor of your computer does not provide a CPU ID. As described
in section 2.3.1.2the most probable reason is that the service providing the CPU ID is
disabled in the computer’s BIOS. You can check and enable this service in the BIOS
configuration mode.

If you cannot find a corresponding service entry in the BIOS of your computer, this means
that its processor does not provide a CPU ID. Note, that currently only Pentium Il pro-
cessors provide this ID; the output above, e.g., stems from an AMD Athlon processor.

e lmhostid -flexid does not return the dongle ID

If lmhostid does not return the ID that is printed on the back of the dongle, check whether
the dongle driver is installed and configured correctly as describselation 2.3.5

If the driver is installed butmhostid still does not return the correct ID, please check the
corresponding port (parallel or USB) of your computer, before requesting a new dongle.

6.5.4 Troubleshooting in HDevelop

This section explains some typical errors while starting HDevelop and their reasons.

Getting Started with HALCON, 2003-08-01



6.5. TROUBLESHOOTING 75

e No license found
This error message might have several reasons:

- The file,HALCONROOT%\1icense\license.dat is missing and/or not readable.
- Your license is not valid on this machine.
- In case of floating licenses: There are too many licenses active.

e Lost connection to license server

Verify if the license server is running. You may also check whether your machine is
properly connected with the server. For this you may need to contact your system admin-
istrator.

¢ No license for this operator
The operator which you try to execute belongs to a HALCON module which is not li-
censed. Obtain a new license including this module.

e \Wrong architecture
This error indicates that you are using an architecture which is not compatible with your
HALCON version. Check the variable ARCHITECTURE or try to install the proper HAL-
CON version.

e hdevelop: Command not found
Check your system environment variabATH. It has to include the path
$HALCONROOT/bin/$ARCHITECTURE.

e lib*: can't open file
For UNIX architectures you have to check the system variabl®@ IBRARY_PATH (see
section 2.4.p

¢ No help files for package<package-name- in directory <directory >
Possible reasons for this error message are:
e No files%HALCONROOTY%\help\* (if the package name is “system”) or no help files
in one of the user packages.
¢ If the package name is “system”: Wrong HALCONROOT
e Check the file protection. Probably HDevelop cannot access important files.
e Help file for package <package-name- is corrupt
Possible reasons for this error message are:

e Ifthe package name is “system”: Inconsistent versiofHa.CONROOT? \help\* or
wrong HALCONROOT

¢ |If the package name is that of a user package: Inconsistent version of the help files
of this package.

e Can't open display
If you see an error message like this you may have a wrong system vabiEgHEAY
and/or your program is not allowed to open a window by the specified X-server.
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6.5.5 Troubleshooting for Parallel HALCON

e Parallel HALCON does not achieve any speedup

If Parallel HALCON does not achieve any speedup on a multi-processor hardware, maybe
you forgot to initialize Parallel HALCON as described section 5.1.1 You must ini-

tialize Parallel HALCON once on each parallel hardware it is to be used on. With this
initialization, Parallel HALCON scans the hardware and checks its potential for parallel
processing.

If you already initialized Parallel HALCON, you can check whether Parallel HALCON
really “found” the processors by calling the operagert_system with the parameter
’processor_num’ (See the corresponding entry in the Reference Manual for more in-
formation). Please note, that this operator must be called from Parallel HALCON to yield
meaningful results; from standard HALCON, it retumeegardless of the actual number

of processors.

Please remember that Parallel HALCON only works on shared-memory systems!

e A Parallel HALCON program runs slower than expected within Visual Studio

Please note, that the developing environment Microsoft Visual Stodssivelynfluences

the scheduling on a multi-processor computer. As a consequence, programs using Parallel
HALCON run slower than expected when startgithin Visual Studio. This concerns

both the automatic parallelization mechanism and multithreaded programs in general.

To get the full performance, create a corresponding executabie-file) and start it
outsideVisual Studio.

e An operator returns different results in HALCON and Parallel HALCON, respec-
tively
This problem can occur if you called the operator with input parameters contdining
ples Note, that certain input parameters of HALCON operators must not receive tuple
values; however, some operators will work without returning an error in such a case. You
can check whether a parameter may receive tuples in the operator’s description (on-line
help or reference manual): Parameters that can receive tuples are marked with the suffix
'(-array)’ after their type, e.g.,Yegion(-array)’.

6.5.6 Miscellaneous Problems

e No refresh of window content on a UNIX system

On some UNIX systems the default behavior regarding occluded windows may be set in
an inconvenient way for HALCON. The result is that if a window is temporarily occluded
by another window, its content is not saved and restored anymore, i.e., windows remain
“black” after uncovering. An example is the Linux distribution SUSE 7.0. The correspond-
ing property is called “backing-store”; you can check the current setting of this property
by typing (the following example corresponds to a SUSE 7.0 Linux system)

xdpyinfo | grep backing-store

which should result in the output like
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options: backing-store YES, save-unders YES

if the window content is saved and restored. You can change this behavior by modifying
the fileXservers residing in the directoryusr/1ib/X11/xdm (Or similar, see your sys-
tem’s documentation). Note, that you probably need root privileges to modify this file.
Append the optiorbs (i.e., “plus backing-store”) to the line that starts the local X server:

:0 local /usr/X11R6/bin/X :0 vt07 +bs

Now, stop and start the X server again (by using the appropriate commands or by rebooting
your computer); the commandipyinfo now should yield the output shown above.
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